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简介 

章节内容 

本节含有以下内容： 

 “本书用途之讲师须知”（第 1-1 页） 

 “关于 Multisim”（第 1-2 页） 

 “本书与电路文件之间的关系”（第 1-3 页） 

 “理论加强”（第 1-4 页） 

 “实验室模拟”（第 1-4 页） 

 “工作台上的实验室”（第 1-4 页） 

 “高度的真实感”（第 1-5 页） 

 “讲师专用实验室”（第 1-5 页） 

本书用途之讲师须知 

本书旨在提供经证实的实用型教学理念的资源，讲师可以在此基础之上进一步拔高。本书含

盖的主题非常广泛，小到基础的直流电路，大到射频通信方面的入门课题。这是一本由讲师

写给讲师的工具书，其目的在于帮助他们以更少的资源取得更多的成就： 

 用更少的时间 

 以更低的学员流失率 

 让您和您的学员获得更大的成就感。 

 

我设计了许多实验室活动，以满足电子学学员在远程学习方面的大部分要求。学员可以自由

学习，而无需担心零部件及仪器故障，既节省了时间，也节约了预算。他们很享受灵活的学

习方式，因为他们可以自行制定学习计划，并在自己的家中完成课业。当学员们已经具备了

使用仪器的能力时，他们就可以接触或应当接触“真实的仪器”了。 

 

我使用 Multisim 已经超过 14 年了，每一次的升级都让我更加喜欢它。随着电子学学习需求及 

要求的增长，该程序还在继续升级。它使用起来非常方便。程序中的仪器和元件与真实的仪

器和元件高度吻合。部分仪器（如：安捷伦万用表、示波器及函数发生器）是物理实验室中

真实存在的仪器。使用 Multisim 所含仪器的学员可立即做到学以致用。这些仪器具有虚拟的 

真实感！有了 Multisim，美国国家仪器（NI）有限公司的 LabVIEW 虚拟仪器就可以使用了， 

信号也可以输出到 LabVIEW 环境中了。此外，Multisim 也整合了输入真实 LabVIEW 信号的 

功能。第 10 节的 SpectrumAnalyzerIntro 实验中给出了一个 LabVIEW 虚拟仪器的实例。NI 

ELVIS 面包板试验环境在本手册通篇当中发挥着辅助作用。  
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Multisim 的部分优势在于： 

 为远程学习提供了虚拟实验室 

 可让学员熟悉仪器和元件的使用 

 其易用性使学员能够专注于电子学的学习 

 可以更高效地讲授故障排除概念 

 

如果您正在从事电子学的教学工作，我相信本书中的许多理念能够对您有所帮助。 

关于 Multisim 和 LabVIEW 

20 多年以来，Multisim 在电子学教育领域一直处于领先地位。期间，Multisim 的数据库加入 

了许多新的功能、元件和仪器。北美电子学领域有 50 多篇权威文章将 Multisim 用作其增补软 

件。虚拟的实验室环境令其成为了许多远程教育课程理论部分的理想实验室。 

 

由电子学领域多位教育家和专业人士开展的一项课题为“用模拟电子学实验室开展分散式在
线学习的有效性”的研究在其摘要中指出，“我们此前曾在大学水平的电子电路课程中用虚

拟实验室代替了一些物理实验室。使用了虚拟实验室的学员在电子学理论的笔试当中成绩远

远优于完全使用物理实验室的学员。他们都同样及时地完成了标准物理实验室的测试项 

目。”1 
 

30 多年来，美国国家仪器（NI）有限公司一直充当着行业标杆的角色。LabVIEW 于 1986 年

首 次发布，工程学领域从此发生了革命性的变化。LabVIEW 是“Laboratory Virtual Instrument 

Engineering Workbench”（实验室虚拟仪器工程平台）的简称，它是一种图形化编程语言，支 

持信号处理和分析所需的 450 多种内置函数。LabVIEW 于 1992 年首次推出了可用于 Windows 

环境的版本。  

 

LabVIEW 将编程语言与专门设计用于试验、计量及自动化的内置工具相结合，实现了很高的 

灵活性，因此，您可以创造出各种各样的应用程序，小到简单的温度监测系统，大到复杂的

模拟和控制系统。无论您的项目是什么，LabVIEW 都有您需要的工具。详情请访问 

www.ni.com/labview/whatis/。  

 

NI ELVIS（NI 教学实验室虚拟仪器套件）是一套基于 LabVIEW 设计而成的样机环境下的应

用 程序。NI ELVIS 由基于 LabVIEW 的虚拟仪器、一套数据采集装置、一套特别定制的台式

工 作站和一个模型板组成。本书所含的许多实验指导都有要求学员在 NI ELVIS 模型板上设

计他们 的电路。  
 

 

                                                 
1
 J. Olin Campbell, John R. Bourne, Pieter J. Mosterman, Mahmood Nahvi, Rassa Rassai, Arthur J. Brodersen & Martine Dawant. (2004). 

用模拟电子学实验室开展分散式在线学习的有效性（第1页），http://msdl.cs.mcgill.ca/people/mosterman/papers/jaln04/p.pdf 

http://www.ni.com/labview/whatis/
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本书与电路文件之间的关系 

本书所有十二节均有大量关联的电路文件。来自许多电路文件的原理图都有一并提供练习 

页，此类实验指导可复制后分发给学员。每张实验指导都会指示学员打开一个文件，运行仿

真程序，然后回答问题。NI ELVIS 练习包含在部分实验指导中。NI ELVIS 实验中展示的面包

板试验 反映了关联的 .ms11 文件内所含的元件值和电路图。每项 NI ELVIS 练习都含有额外的

问题来 扩充学员对电路行为的理解。 

 

通过高亮某个元件或仪器，然后按下 F1，学员和讲师们便能够看到所选项目的帮助内容。  

 

“示波器”、“波特图绘制器”、“频谱分析仪”和“网络分析仪”这几节都有提供一张仪

器本身的照片。此照片可复制后分发给学员，也可以通过幻灯片投影来讨论。频谱分析仪的

使用方法列于文件 SpectrumAnalyzerIntro.ms11 的说明框中。  

多数电路文件都有说明框，并带有小测验和实验指导。您可以创建自己的说明框，并将文件

用于实验室作业或测验，此类作业或测验将通过磁盘、网络或（远程学习的情况下）电子邮

件方式来提交。学员可以回答说明框内的所有说明框问题。所有电路文件都起好了文件名，

文件名清晰地说明了文件的性质，但您想隐藏起来不让学员看到的那些文件除外。 

 

本书含盖的主题非常广泛，小到基础的直流电路分析，大到射频通信系统。故障排除方面最

重要的话题在第 5 节中有详细的交代。本节指导您如何给故障设定密码，以拒绝学员访问。  

 

第 11 节介绍了 Network Analyzer（网络分析仪），同时也向学员说明了模拟仪器的各种功

能和 特点。有关 Network Analyzer（网络分析仪）的更多信息，请浏览 Multisim 的帮助文

件或我 的实验室手册《利用 Multisim 进行射频通信》。 
 

第 12 节介绍了 Multisim 独特的测评性能。您将看到创建多项测试并进行打分的简单方法，以 

及在给各题型分配分数时提高公正度的策略。问题链接功能是一项非常易用的测试功能，通

过它，您可以轻松地设置正误判断题和选择题。学员可以在电路文件中答题，然后通过电子

邮件将答案提交给您。第 12 节的所有练习以及练习册中的其他多个文件均含有正误判断题及

/或选择题。在许多文件里，学员须在 Multisim 中制作其试验电路。面包板试验的指示可见于 

每个文件的说明框中。 

 

所有策略、流程及电路文件都可以根据您个人的要求进行调整。 
 

理论加强 

这里所学的材料在传统或虚拟的课堂当中都很有用。基础理论部分将讲授关联的计算过程，

以及电路行为的预测依据。  
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电路、模拟、说明框及仪器都可以进行打印。打开仪器窗口，然后按下 ALT-PRINT SCREEN

就可以将仪器拷贝到剪贴板。然后，副本可以粘贴到文字处理软件、PowerPoint™  或其他软 

件中。  

实验室模拟 

本书引用了 130 个电路文件，每个文件都可以单独模拟。这些电路附带了传统的实验练习和

小测验。学员运行模拟，并将模拟结果与理论上的计算结果进行比较，然后鼓励学员就任何

差异进行思考。元件值可能会有所改变，电源值可能会增加或减少，电位器和可变电容器值

可能会改变，整个电路可能发生变动。执行模拟时，结果会即时显示出来。 

 

学员没有被局限在理论结果上。为了模拟出真实的元件行为，我们可以设定容差。你会发 

现，Multisim 提供了一个高度互动的环境，里面有数量无限的部件及多个仪器可用来克服传 

统实验室中常见的比较耗时的局限性。  

 

最新版的 Multisim 加入了许多新的元件和功能，其中包括：多种传感器、一个 3 相电源、一

个 压控电阻、多个安捷伦测量仪表、一个示波器、一个伏安表、多功能动态测量探头、可根

据仿真数据进行显示的说明框、一个面包板试验窗口、包括电子表格视图在内的多种特色功

能，以及页外连接器。此外，新版本中还有给说明框加入声音和视频的功能。第 4 节中加入

了晶体管电路向导实验的内容。晶体管电路向导功能有可能会为您节省时间，学员可以通过

它来学习各种参数，以达到扩充理论和实验室知识的目的，从而更加真实地了解晶体管。正

如简介中所谈到的，问题链接功能使测试内容的生成过程变得更加灵活易用。多项实验都有

包含钳式电流探头。  

工作台上的实验室 

已经认识了 Multisim 中各类电子仪器的学员们会发现向工作台设备的过渡非常简单。他们现 

在有权使用真正的仪器了。他们不是在学习主题领域背后的理论，而是已经掌握这些理论 

了。现在，他们可以集中注意力来使用设备、购买和识别元件、找出真实的实验室环境里可

能出错的地方了。他们学得很好，因为他们的任务并不过重。您会在整体上获得怎样的好处

呢？依我的经验，这意味着您会在毕业日那天拥有更多值得骄傲的学员。 

高度的真实感 

作为简单的 3D 元件的演示，请打开第 1 节文件夹里的 AsRealAsItGets.ms11 并执行仿真。请记

住，与真实的函数发生器一样，在使用之前请打开安捷伦函数发生器、安捷伦示波器及泰克

示波器。 
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AsRealAsItGets.ms11 

讲师专用实验室 

打开文件 ToTheInstructor.ms11 查看或播放学员工作区的定制方法，从而让一个或多个工具栏

无法被学员所用。 
 



 

 

第 1 节：直流电路及戴维南定理 

章节内容 

本节含有以下内容： 

 “第 1 节简介”（第 1-9 页） 

 “强化基本电路行为的概念”（第 1-10 页） 

 “安捷伦万用表”（第 1-12 页） 

 “压控电流源及三相电源”（1-13 页） 

 “利用可变电阻及开关来改变电路参数”（第 1-14 页） 

 “压控电阻”（第 1-16 页） 

 “额定元件”（第 1-17 页） 

 “戴维南定理”（第 1-18 页） 

本节实验指导 

下列实验指导始于实验指导 1-1 之第 1 页：电阻色环： 

 

 “实验指导 1-1：电阻色环”  

 “实验指导 1-2：基本电路” 

 “实验指导 1-3：基本电路” 

 “实验指导 1-4：可变电阻特性”。 

本节电路 

下面列出了本节所用电路的名称，以及每个电路的简要描述。 
 

文件（.ms11） 描述 

Agilent Multimeter 许多实验室所用真实仪器的实例。 
欧姆 串并联电路行为实例。 
RatedComponents Multisim 在两个独立电路中的额定元件实例。 
Two OtherSources 除了有压控电流源之外，Circuit A（电路 A）与 Ohm.ms11 是相同

的。Circuit B（电路 B）是一个连接了四通道示波器的三相电源。 
Ohms2 利用可变电阻及开关来改变电路中的值。 
电阻色环 利用 Multisim 的 3D 元件来模拟色环实验。 
Thevenin1 戴维南法电路分析。 
Thevenin1A-Thevenin1C 戴维南分析法的三个步骤（等效电路）。 

（适合投影仪或通过 PowerPoint 来使用）。 
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Thevenin1TS Thevenin1 的故障版本。 
Thevenin2 对双电源电路使用戴维南分析法。 
Thevenin2_TS Thevenin2 的故障版本。 
VoltageControlledResistor 压控电阻设置及行为实例。 
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第 1 节简介 

Multisim 鼓励使用多个仪器。这意味着可同时监测的运行特性数量是不受限制的。学员可以 

利用这个独一无二的机会，改变整个原理图中各个目标区域里的某个特定元件，并观察其结

果。该功能可以即时呈现结果，并为电子学教学当中遇到的“如果...会怎样？”这种情形提

供了完美的解决途径。 

 

您可以让学员预测电路行为并观察瞬时结果。我们鼓励学员积极互动，并以一种能够“整 

合”基本概念的方式来思考。这样可以减少课堂教学或远程教学的时间损耗。 

 

在以下情形下尝试加强学员对基本电路行为的理解时，解答“如果...会怎样？”这类询问的

能力是极为重要的： 

 在远程教育的情形下 

 在示范讲座的情形下 

 在软件实验室环境下。 

 

远程教育的其他好处在于，学员能够自主地熟悉模拟仪器，此类模拟仪器与他们在传统实验

室里看到的仪器高度吻合。这能在很大程度上减少用真实的仪器和元件学完课程所需要的时

间。 

 

第 1 节提供的实验指导进一步鼓励学员积极互动。为了让学员早期了解故障排除流程，我们

加入了两个含有故障的文件。双击目标元件可以更改电压和阻抗值。可使用多个动态测量探

头来快速有效地测量整个电路的电压。要开始电路的运算仿真，学员可以选择 Simulate»Run 或

点击开关按钮来启动仿真程序。 
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强化基本电路行为的概念 

目标 

强化串并联电路中基本电路行为的概念。 

前提 

我们假定学员已经掌握了电压和电流的计量单位，并会使用 Multisim 的各种仪表和电压探 

头。 

注释 

为了逼真地模拟出真实的实验室环境，每个元件可以设置一定的容差。要设置容差，请双击

目标元件。 
 

 

图 1-1：Ohm.ms11 
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流程 

1. 打开文件 Ohm.ms11。 

2. 计算电路中所有电压及电流的值。将这些值记录在实验指导中。 

3. 用电源开关或在菜单中选择 Simulate»Run 来求解电路，并根据计算出的值检查实测值。 

4. 为任一电阻选择一个新的值。 

5. 预测电路中各电压及电流的变化趋势（值会增加、减少还是没有变化），然后将预测结果

记录在实验指导上。 

6. 计算电流及电压的新值并记录下来。 

7. 用电源开关或在菜单中选择 Simulate»Run 来求解电路。对比预测值和模拟值。 

 

该电流探头发挥着钳式电流探头的作用，它可以将流经电缆的电流转换成探头输出端的电 

压。在这个电路中，探头输出端连接了万用表。要使用它，请将万用表设置成 V，并将其读

数以 1V/mA 转换为安培。  

相关实验指导 

“实验指导 1-2：基本电路”。 



第 1 节：直流及戴维南定理  1-11 

 

 

 

Agilent Multimeter 

目标  

让学员熟悉 Multisim “逼真”的模拟万用表。实验将指导学员完成真实万用表的基本使用 过

程，包括故障排除情形下用到的连续性测试功能。 

注释 

安捷伦万用表的位置在仪器工具栏的右下角。 

流程 

1. 打开 AgilentMultimeter.ms11。 

 

图 1-2：AgilentMultimeter.ms11 

2. 打开说明框。 

3. 点击开关或选择 Simulate»Run 菜单来执行仿真程序。 
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压控电流源及三相电源 

目标 

让学员熟悉 Multisim 的压控电流源及三相电源。 

注释 

TwoOtherSources.ms11 Circuit A（电路 A）含有与 Ohm.ms11 相同的电路，唯一的区别是，它利用 

了压控电流源。输出电流 I2 取决于施加给输入端的电压。两者的关联在于输出电流与输入电

压之比，即：跨导。此比率被设定为 1 x 10e-3 Mhos。数据库中还有压控电压源、流控电压源

及 流控电流源。Circuit B（电路 B）是对三相电源使用 Multisim 四通道示波器的一个实例。

三相电源 在数据库中也有提供。 

流程 

1. 打开 TwoOtherSources.ms11。观察 Circuit A（电路 A）。 

 

 

图 1-3：TwoOtherSources.ms11 

2. 点击开关或选择 Simulate»Run 菜单来执行仿真程序。 

3. 对比指示器上显示的值和您从 Ohm.ms11 中得出的值。 

4. 观察 Circuit B（电路 B），按照说明框的指示来操作。 
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利用可变电阻及开关来改变电路参数 

目标 

观察串并联电路的行为。 

注释 

为了逼真地模拟出真实的实验室环境，每个元件可以设置一定的容差。要设定容差，请双击

目标元件。 
 

 

图 1-4：Ohms2.ms11 
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流程 

1. 打开电路文件 Ohms2.ms11。 

2. 闭合开关。将电位器设置为 25%。求解电路并计算 R3 的值。 

3. 按下 A 或 SHIFT-A 来更改 R3 的值直至读数显示为 60%。您也可以将指针移动到电 位器上

方并拖动出现的滑块。在仿真过程中也可以调节电位器。  

4. 预测电路中各电压及电流结果的变化趋势。 

5. 利用电压和电流测量值计算 R3 的新值。 

6. 求解电路，对比预测值和模拟值。 

7. 断开开关。预测电路中各电压及电流的变化趋势。 

8. 求解电路。执行仿真程序，然后对比您得出的结果。 

相关实验指导 

“实验指导 1-3：可变电阻实验”。 



第 1 节：直流及戴维南定理  1-15 

 

 

 

压控电阻 

目标  

让学员熟悉 Multisim 的压控电阻（VCR）。电路中，压控电阻与其他各种电阻组合使用，以 

便创建有源器件模型。该实验集中介绍压控电阻是如何在电路中发挥功能的。 

注释 

电压表和安培计可见于指示器元件组中。 

 

 

图 1-5：VoltageControlledResistor.ms11 

流程 

1. 打开 VoltageControlledResistor.ms11。 

2. 打开说明框。 

3. 点击开关或选择 Simulate»Run 菜单来执行仿真程序。 
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额定元件 

目标 

强调真实的实验室环境中所用额定元件的重要性。   

注释 

使用非模拟环境下的真实实验室来进行该实验也是可行的，只是我们因其固有的风险而一般

不去尝试。 

 

 

图 1-6：RatedComponents.ms11 

流程 

1. 打开 RatedComponents.ms11。 

2. 打开说明框。 

3. 点击开关或选择 Simulate»Run 菜单来执行仿真程序。
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戴维南定理 

本节剩余文件对戴维南定理进行了介绍。 

 电路文件 Thevenin1.ms11 含有提供了学员实验指导的说明框，这些实验指导利用该网络分

析法一步步帮助学员求解电路。 

 电路 Thevenin1A 至电路 Thevenin1C 展示了利用戴维南定理求解电路的每个步骤。 

 电路文件 Thevenin2 提供了一个更加复杂的双电源电路，高阶训练可以用到它。 

 

注 电路 Thevenin1.ms11 以及电路 Thevenin1A 至 Thevenin1C 的逐个步骤文件可以在实验之

前打印——用于投影或通过 PowerPoint 进行课堂展示。 

目标 

通过仿真，演示并练习使用戴维宁定理分析复杂电路的步骤。 

前提 

我们假定学员已经掌握了串并联电路的求解方法。 

您需要用到以下电路文件： 

 Thevenin1.ms11 

 Thevenin1A.ms11 至 Thevenin1C.ms11 

 Thevenin2.ms11。 

注释 

对学员而言，计算等效电路可能是一个非常困惑的过程。戴维南法非常简单易懂，因为课本

中大部分内容所述的详细分析步骤可以在解题时直接照搬使用。 



1-18  PMultisim 之实用教学理念 

 

 

流程 

1. 打开电路文件 Thevenin1.ms11。说明框中含有一份学员实验指导样本。若要用于学员作业

或小测验，您可以更改值或替换课本中的电路。 

 

 

图 1-7：Thevenin1.ms11 

2. 测量初始负载电压及电流。 

3. 断开负载电阻，将其移至工作区的任一其他地方，如：原电路下面。（见文件

Thevenin1A.ms11）。 

 

 

图 1-8：Thevenin1A.ms11 
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4. 让学员用仪表测量开路电压，然后用该值创建一个直流电源。 

5. 下面，在所有直流电源被断开并换上短接导线的情况下，让学员测量开路 电阻。用该值创

建一个电阻。（见文件 Thevenin1B.ms11）。 

 

 

图 1-9：Thevenin1B.ms11 

6. 将 Vth、Rth 及初始负载电阻连接成一个独立且更加简单的电路。这便是 Thevenin 

Equivalent Circuit（戴维南等效电路），该电路的行为将与原电路完全相同。 

 

注： 现在，一个直流电源，一个电阻，外加这个负载电阻的组合取代了整个电 

路。（见文件 Thevenin1C.ms11）。 

 

 原电路和新的戴维南电路通过负载电阻的电压和电流是相同的——当您能做 

出这个结果时，便说明该过程是合理的。通过改变原电路和 Thevenin 

Equivalent Circuit（戴维南等效电路）中的负载电阻值，您可以证实该定理 

的作用。学员将看到其结果是相同的，从而证明戴维南等效电路的电压和电

阻是独立于负载电阻的。 
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图 1-10：Thevenin1C.ms11 

概念扩展 

利用 PowerPoint 或是通过投影仪展示打印材料的方式，Multisim 既可用于远程教育，也可用 

于课堂演示。使用计算机实验室不但可以使大量的学员逐步经历许多实例，同时还能促进他

们对基本理论的掌握。 

 

一旦学员理解了戴维南定理的基本概念，他们就可以将其应用到来自任何直流和交流理论课

本的各种电路当中去，也可以将其应用到有源器件中去，比如：晶体管和场效应晶体管。 

 

电路 Thevenin2.ms11 提供了一个更加复杂的双电源电路实例。学员可以利用 Thevenin1 中相同

的分析步骤来分析该实例。电路 Thevenin1 至 Thevenin1C 包含了原电路和使用戴维南定理的分

步流 程。 

 

电路可以从任何课本的实例中提取，然后用它们来替换给出的实例。 
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挑战课题 

两个电路文件含有故障，并以字母“TS”来表示。作为讲师，您可能会通过以下方式观察到

这些故障：取消 Options»Circuit Restrictions»General 标签下对隐藏元件故障复选框的选择。如果您 

提供了密码，您就可以在分发文件之前禁止学员访问。 

 

Multisim 针对巩固和加强基本理论提供了理想的故障排除环境。说明框用于指导学员完成整 

个故障排除过程。该练习册的故障排除一节有进一步鼓励学员加强解题逻辑。与本节相关的

故障排除电路为 Thevenin1TS.ms11 和 Thevenin2TS.ms11。 

参考 

主题  参考 

万用表 Multisim 帮助文件 

安培计 Multisim 帮助文件 

电压表 Multisim 帮助文件 
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实验指导 1-1： 

电阻色环 

姓名：________________________ ID 号：___________________ 班级：___________ 

开始 

打开文件 ResistorColorCodes.ms11。 

练习 

根据下列电阻色环来相应电阻的值。 

 

 1.     黄色，紫色，棕色 __________________ 

 

 2.    黄色，紫色，红色      __________________ 

  

 3.    红色，红色，红色      __________________ 

 

 4.    棕色，黑色，红色  __________________ 

 

 5.    棕色，黑色，橙色  __________________ 

 

 6.    棕色，黑色，黑色  __________________ 

 

 7.    橙色，白色，红色 __________________ 

 

 8.    绿色，蓝色，黄色 __________________ 
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 9.    灰色，红色，橙色 __________________ 

10.  白色，棕色，蓝色 __________________ 

 

11.  棕色，黑色，蓝色 __________________ 
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实验指导 1-2： 

基本电路 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 Ohm.ms11。 
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练习 

1. 根据该电路填写下表。 

 
物理量 计算值 实测值 差异（%） 

It 
   

V1 
   

I2 
   

I3 
   

I3 
   

V2/3 

   

 

2. 预测电路的一般行为： 

 

如果________改为________，预测的变化趋势则为：________ 

（增加、减少、保持不变）。 
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NI ELVIS 练习 

开始 

1. 在 Multisim 中打开文件 Ohm.ms11。   

2. 在您的 NI ELVIS 面包板上创建电路 Ohm.ms11，如下图所示。 

 

 
 

练习 

1. 根据该电路填写下表。展示计算结果。  

物理量 计算值 模拟值 实测值 差异（%） 

It     

V1     

I2     

I3     
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2. 这些观测值是否与您的计算结果和模拟结果相吻合？如果不吻合，原因何在？ 

 

 

 

 

 

 

3. 预测电路的一般行为（增加、减少还是保持不变）： 

a) 如果 R1改为 100 Ω，I2将会 _________________。 

b) 如果 R1改为 2 kΩ，It将会 _________________。 

c) 如果 R2改为 2 kΩ，I2将会 _________________。 

d) 如果 R2改为 100 Ω，V1将会 _________________。 

e) 如果 R2改为 100 Ω，I3将会 _________________。 

f) 如果 R3改为 100 Ω，I3将会 _________________。 
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实验指导 1-3： 

基本电路 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 Ohms2.ms11。 
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练习 

1. 根据该电路填写下表。 

 
物理量 变化方向 计算值 实测值 差异（%） 

It 
    

V1 
    

I2 
    

I3 
    

I3 
    

R3 

    

 

 

NI ELVIS 练习 

开始 
1. 打开文件 Ohms2.ms11 in Multisim。   

2. 在您的 NI ELVIS 面包板上创建电路 Ohms2.ms11，如下图所示。 
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练习 
1. 根据该电路填写下表，这里的电位器被设置为 25%。 写出计算过程。 

  

物理量 计算值 模拟值 实测值 差异（%） 

R3 

    

It 
    

V1 
    

I2 
    

I3 
    

 

2. 如果电位器增加到 60%，请预测电路中各电压及电流结果的变化趋势。  

 
物理量 变化趋势 

It  

V1  

I2  

I3  

 

3. 根据该电路填写下表，这里的电位器被设置为 60%。 

 
物理量 计算值 模拟值 实测值 差异（%） 

R3     

It     

V1     

I2     

I3     

 

4. 将模拟电位器改为 73%。利用电压和电流测量值计算 R3 的新值。写出计算过程。 

 

R3 = ________________ 欧姆
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5. 如果开关是断开的，请预测电路中各电压及电流结果的变化趋势。 
 

物理量 变化趋势 

It  

V1  

I2  

I3  

 

6. 根据该电路填写下表，这里的开关处于断开状态。 

 
物理量 计算值 模拟值 实测值 差异（%） 

It     

V1     

I2     

I3     
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实验指导 1-4： 

可变电阻特性 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开电路文件 Ohms2.ms11。 

练习 

1. 闭合开关。 

2. 将电位器设置为 25%。 

3. 求解电路并计算 R3 的值。写出计算过程。 

R3 = ________________ 欧姆 

4. 按下 A 或 SHIFT-A 更改 R3 的值，直至读数显示为 60%，（住址期间可以调节电位器）。

您也可以将指针移动到电位器上方并拖动出现的滑块。预测电路中各电压及电流结果的变
化趋势。写出计算过程。 

 

5. 利用电压和电流测量值计算 R3 的新值。写出计算过程。 

 

R3 = ________________ 欧姆 
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6. 求解电路，对比预测值、模拟值和实测值。 

 

 

 

7. 断开开关。预测电路中各电压及电流的变化趋势。 

 

 

 

8. 求解电路。 

 

9. 执行仿真程序，然后对比您得出的结果。 

 
 



 

 

第 2 节：由波特图绘制器引入示波器及滤波器 

章节内容 

本节含有以下内容：  

 “介绍示波器”（第 2-3 页） 

 “介绍波特图绘制器”（第 2-5 页） 

 “低通滤波器”（第 2-7 页） 

 “RLC 串联谐振电路滤波器”（第 2-9 页） 

 “同时比较：有源及无源滤波器”（第 2-11 页） 

 “安捷伦示波器”（第 2-12 页） 

 “向导”（第 2-14 页） 

本节实验指导 

下列实验指导始于实验指导 2-1 之第 1 页：示波器 1： 

 

 “实验指导 2-1：示波器 1” 

 “实验指导 2-2：示波器 2” 

 “实验指导 2-3：用示波器测量幅值与相移” 

 “实验指导 2-4：低通滤波器” 

 “实验指导 2-5：串联谐振电路滤波器” 

本节电路 

下面列出了本节所用电路的文件名，以及每个电路的简要描述。 
 
文件（.ms11）  描述 
AgilentOscilloscope 介绍在许多实验室所使用的真实仪器。 
Filter 1 介绍波特图绘制器。在线性和对数坐标轴上设置比例尺，并使用标记

精确测量谐振电路低通滤波器。分贝表示法及相位测量 
Filter 1TS Filter1.ms11 的故障版本。 
Filter2 用运算放大器分步对比无源谐振电路滤波器及有源滤波器的 

负载性能及无载性能。 
Filter3 用波特图绘制器研究无源带通滤波器。 

 
文件（.ms11）  描述  
Filter4 用波特图绘制器研究无源陷波滤波器。 
Filter4TS Filter4.ms11 的故障版本。 
Scope1 介绍示波器。测量幅值与时间，并计算频率。 
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Scope2   调节示波器显示信号的技巧（这里的示波器被设置成了初始值）。 
Scope3 用示波器测量相位及幅值。 
Wizard1 介绍滤波器向导的使用方法。 

 

利用 Multisim，学员可以了解示波器的设置，并且在一个对仪器和元件毫无损害的环境下学

习这 些设置与电路分析的关系。 

 

在远程学习的情况下，由于学员经常使用自己的计算机，他们可以利用充足的时间来学习该

仿真程序，然后再接触真实的仪器。在更加传统的课堂环境里，您可以要求学员演示模拟仪

器的正确使用方法，然后再让他们操作真实的仪器。 

 

本节主要介绍示波器及波特图绘制器在 Multisim仿真环境下的使用方法。周期、幅值及频率

将 由文件 Scope1.ms11 提供的波形来决定。学员将认识电压源上的均方根值转换功能。 

 

文件 Scope2.ms11 含有一个显示示波器初始设置的电路。随附的实验指导将要求学员预测应当

移动的示波器控制装置及其调节方向，以便最准确地观测波形。幅值偏移及相移将利用 

Scope2.ms11 来测量。文件 Scope3.ms11 中提供了一个低通滤波器。3 分贝点上将使用示波器来

测量，以便学员完整了解波特图绘制器的作用。 

 

文件 AgilentOscilloscope.ms11 中还提供了另外一个示波器教程。电路文件 Filter1.ms11 和 

Filter2.ms11 中额外提供了一个低通滤波器和一个高通滤波器。文件 Filter3.ms11 和 Filter4.ms11 

中还含有一个带通滤波器和一个带阻滤波器。这些文件的命名不会让学员知道每个文件中包

含了哪种滤波器。 
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介绍示波器 

目标 

给学员介绍正确使用示波器来测量频率和重复波形幅值的方法。 

预备知识 

您需要用到电路文件 Scope1.ms11。 

 

我们假定，学员： 

 已熟悉绘图以及为图形、频率、周期及幅值设定坐标的基本概念 

 能够将正弦波的均方根值转换为峰值和峰峰值。 

 已进行过有关示波器功能的入门练习（讲座、视频、课本阅读任务等），包括：设置垂直

轴灵敏度（V/Div，即：伏/格）和水平轴灵敏度（时基）来实现可能的最高精确度。 

注释 

本节含有两份实验指导和两个电路文件。首先要求学员利用电路文件 Scope1.ms11 来计算周

期、幅值及频率。文件 Scope 2.ms11 要与第二份实验指导配合使用。它提供了一个信号发生

器，该信号发 生器连接了一个被设定为初始设置的示波器。该实验指导要求学员思考显示内

容与示波器设置的关系、需要改变哪些控制装置以及以怎样的方向改变，以便有效地显示出

有实际意义的值。 

 

注 在仿真过程中，学员随时可以点击 Pause（暂停）键来冻结模拟过程并进行更加准确的 

测量。 

流程 

本节课可以采用讲座的形式，利用 Multisim 来演示示波器的使用方法。如果是按照这个方式 

来讲课，我建议您给学员提供以本课为主旨的实验指导，这有助于让学员将注意力集中在课

题上。 

 

让每位学员完成实验指导。完成后，以班级的形式讨论结果。  



2-4  PMultisim 之实用教学理念 

 

 

 

相关实验指导 

 “实验指导 2-1：示波器 1” 

 “实验指导 2-2：示波器 2” 

 “实验指导 2-3：用示波器测量幅值与相移” 

概念扩展 

您需要用到以下文件： 

 Scope2.ms11 用于示波器基础练习 

 Scope3.ms11 用于相移测量 

 AgilentOscilloscope.ms11 用于示波器的补充性基础练习 

 

做完这三项入门练习后（Scope1、Scope2 及 AgilentOscilloscope），学员仍需练习并熟悉示波

器。您可能需要开展一系列的示波器课程，让学员熟悉示波器的下列功能： 

 交流/直流耦合以及测量直流电压 

 垂直及水平位置控制的应用 

 触发功能的原理和应用 

 AUTO（自动），A，B，EXTERNAL（外部） 

 测量相移（时域） 

 利用李萨如图形测量相移 

 B/A 及 A/B 控件设置的应用。 

用示波器测量相移 

文件 Scope3.ms11 给出了在简单谐振电路滤波器上综合测量相位及幅值的实例。文件说明框中

含有一份推荐的学员实验指导。 

参考 
 
主题 参考 
函数发生器 Multisim 帮助文件 

示波器 Multisim 帮助文件 

 

 

 

介绍波特图绘制器 

目标 

 介绍利用波特图绘制器分析选频电路的概念 

 使用波特图绘制器显示范例电路的电压响应和相移（可选） 

 说明波特图绘制器在支持比率、对数及分贝等数学概念方面的作用。 
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预备知识 

您需要用到电路文件 Filter1.ms11 和 Filter2.ms11。 

我们假定，学员： 

 已经知道如何计算容抗及感抗 

 能够将电阻与电容器和电感器组合起来得出总电抗 

 能够以图形方式或通过计算器来计算电路的相角 

 能够辨认两个正弦波的示波器轨迹，指出幅值和相移，并能够测量示波器上的正弦

波幅值 

 能够将电压比转换成分贝表示法并将分贝转换成电压比（可选）。 

有关波特图绘制器操作的一些说明 

1. 在垂直轴上： 

 F 表示终值。在线性模式下，它是输出与输入的最大预期比率。在对数模式下，它是

预期的最大分贝增益或衰减。 

 I 表示初始值。在线性模式下，它是最小的预期比率。在对数模式下，它是最小的分

贝增益或衰减。 

2. 在水平轴或频率轴上： 

 F 是所需的最大频率，I 是所需的最小频率，它们是针对感兴趣的目标频率而选取的。 

3. 纵向光标（只在水平轴上移动）能够轻松实现精确的测量。 

 数字读数提供了光标与所绘曲线交叉点的坐标。 

4. 购买波特图绘制器时，您需要一个信号源。函数发生器或正弦波电压源均可接受。 

 

 

波特图绘制器在讲授频率响应方面如何发挥作用 

许多老师希望尽快介绍频率响应，因为这样能够说明：即使是很简单的电路也能发挥很重要

的作用。但他们有时候欲言又止，因为，除了教授理论外，掌握这部分知识还要求具备更多

的数学基础。 

 

低通电路的数学分析难度很大，但概念本身并不难。其原理可以很简单地陈述完毕： 

 在低频带，通过低通滤波器的输出电压几乎与输入电压一样大。 

 输出电压会随着输入频率的增加而下降。 

 

从这段陈述当中，学员可以自行得出如下结论：必然有一个截止频率点，从此点开始电压开

始变化。 

 

我们可以打印出 Multisim 中的波特图，放映在投影仪上展示出不同电路参数下的渐进式响应

曲线。这种幻灯片对分发教学材料而言也非常有用，尤其是在没有 PowerPoint 可用的情 况

下。 
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波特图绘制器是让学员认识滤波器和谐振电路的理想工具。频率响应的概念可以通过波特图

绘制器上显示的幅值频率响应来清晰地加以说明。 

 

使用 Multisim 时，仪器的可用性不是问题，所以，需要时可以颠倒频率响应的讨论顺序： 

 首先，波特图绘制器的曲线图体现了电路的整体频率响应。例如，截止（拐角）频率在双

对数波特图上是显而易见的。 

 学员已经看到了波特图绘制器上的结果，因此，您可以展开讨论如何使用示波器上测量同

样的参数。因为使用用示波器绘制滤波器响应图是一项非常耗时的工作，所以最好在开始

工作之前就让学员们知道接下来他们要做的将是什么样的事情。 

 

利用波特图绘制器，您可以就频率响应展开全面的讨论。一旦学员们通过分析波特图理解了

这些概念，表示他们对这部分知识已经有了全局的了解，这样您就可以介绍后续的理论了。 

 

当您演示谐振电路时，结果会更加惊人。RLC 串联电路的谐振频率在波特图上是显而易见 

的。在参考波特图的情况下，带宽的概念会更容易讲授。 
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低通滤波器 

让全班学员想象一下，源频率增加时输出电压会有什么变化。经过一番讨论后，他们应当意

识到，降低电容器的阻抗会影响到输出。当学员们知道了穿过电容器的电压会下降时，他们

就可以继续学习电路 Filter1.ms11 了，在这个电路中，在 RC 网络中附上了一个波特图绘制

器，如下图所示。 

 

 

图 2-1：Filter1.ms11 

如果水平和垂直标尺上都采用了对数坐标，波特图会显示（几乎）恒定的输出，直至截止频

率。在此之后，输出电压则随着频率的增加以线性方式下降。 

 

如果垂直标尺上采用了线性坐标，水平标尺上采用了对数坐标，那么，波特图显示的输出是

随着频率的增加而下降的。 

 

一旦整体行为通过该图讲解清楚了，您或许想让学员使用波特图绘制器的 Marker（标记器）

功能 以选取指定的频率进行测量。他们唯一需要做的是，找出想要的频段，为线性范围选择

合理的设置。 

 

注 给出的 Marker（标记器）位置的读数是输出与输入的电压比率，而非绝对电压。 
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讨论到这里，您或许想改而测量相位，以便说明电路的相移与频率变化之间的关系。在不同

的频率下进行相位的测量会加深学员对电路行为基本概念的理解。 

 

一旦学员掌握了如何使用波特图绘制器来测量相移，请让他们用示波器取代波特图绘制器，

比如在电路 Scope3 中。他们可以练习使用示波器来以传统的方式测量相差。 

 

 

图 2-2：Scope3.ms11 

在波特图绘制器上完成了测量之后，学员就可以进行一些分析工作了。他们可以对一些选定

的频率进行计算，以确认读数。部分学员可能使用对数进行运算感觉会更加方便，他们将加

强自己在分贝和比率之间来回转换的能力。 

 

此外，他们可以连接上示波器（而非波特图绘制器）以确认所选频率（比如截止频率）的结

果。这里，输出电压将是电压源的 0.707 倍，相差为 45 度。当学员意识到他们可以使用波特

图绘制器（而不必不止境地重复电压比和相位计算过程）时，他们会更容易接受和掌握频率

响应的概念。 

 

演示过这些基本概念后，您可以利用电路中的可变电阻来改变阻抗。如果可行，您可以让学

员参考下面几页的任一实验指导中的范例电路图来练习新的电路。 

相关实验指导 

“实验指导 2-4：低通滤波器” 
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RLC 串联谐振电路作滤波器用 

研究过非谐振滤波器之后（输出电压总是小于源电压），学员通常会惊讶地发现，部分无源

电路产生的输出电压要比源电压大出好几倍。 

推荐的流程 

您可以让学员预测 RLC 串联电路的响应曲线。然后，帮助学员理解输出电压在谐振频率上达

到峰值的原因。波特图绘制器的曲线图让结果变得非常清晰。您可以看到电路电阻对谐振峰

值产生的影响，以及变化中的电容或电感值是如何改变谐振频率的。在做完此类定性任务

后，学员应当会更乐意执行一些计算来验证其观察到的结果。 

前提 

您需要用到以下文件： 
 Filter1.ms11 

 Filter2.ms11 

 Filter3.ms11 

 Filter4.ms11 

 Wizard1.ms11 

相关实验指导 

“实验指导 2-5：串联谐振电路作滤波器用” 

概念扩展 

研究过该 RLC 串联谐振电路的基本特点后，可以通过观察谐振频率上 L或 C 的变化效果及带

宽上电路电阻的变化效果来进行进一步的研究。 
 

 



2-10  PMultisim 之实用教学理念 

 

 
 
 

 

 

图 2-3：Filter3.ms11，显示了波特图绘制器 
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电路功能对比：有源及无源滤波器 

文件 Filter2.ms11 展示了如何利用 Multisim  来同时比较两个理论上功能相同的电路的特点。 

（在这个比较范例下，它们一个是使用简单 RC 电路的低通滤波器，另一个是使用运算放大器

有源滤波器）。 

 

该文件可以让学员对两个电路带载和空载时的特点进行比较，从而找到一个电路相对于另一

个电路所具有的优势。 
 

 

图 2-4：Filter2.ms11 

通过 Multisim，学员可以同时研究这两个电路，以评估每个电路的优势或劣势。通过给每个

电路加载一个合理的负载值可以说明有源滤波器 的优势（比如：一个与滤波电阻值相同的负

载）。 

 

文件的说明框中针对各电路的基本研究提供了推荐的实验指导。 
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安捷伦示波器 

目标  

让学员熟悉 Multisim 的安捷伦示波器，为学员演示在模拟环境下使用真实示波器的优势。此

外，该实验室还证明了使用 Multisim 的另外一个优势：可以使用系统提供的分级模块。  

注释  

安捷伦示波器可以在“仪器”工具栏中找到。  

流程 

1. 打开 AgilentOscilloscope.ms11。 

 

 

图 2-5：AgilentOscilloscope.ms11 
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2. 打开说明框，完成所有分级模块的步骤。  

3. 点击开关或选择 Simulate»Run 菜单来执行仿真程序。 

 

向导 

目标  

让学员熟悉 Multisim 的滤波器的生成功能。在学习滤波器行为时演示“向导”功能的优势。 

注释 

该滤波器向导可见于“工具”菜单下。 

流程 

1. 打开 Wizard1.ms11。 

2. 打开说明框并完成各步骤。 

3. 点击开关或选择 Simulate»Run 菜单来执行仿真程序。 
 

挑战课题 

三个电路文件含有故障，并以字母“TS”来表示。要观察这些故障，请取消 Options»Circuit 

Restrictions»General 标签下对隐藏元件故障复选框的选择，然后双击元件和电源。如果您设置了 

密码，您就可以在分发文件之前禁止学员访问。说明框用于指导学员完成整个故障排除过  

程。该练习册的故障排除环节可以进一步加强学员的解题逻辑。故障排除文件为 

Filter1TS.ms11、Filter3TS.ms11 和 Filter4TS.ms11。 

 

 

 

 





  第1页，共 4 页 

 

 

© 2010 National Instruments Corporation. 允许复制本页用于课堂教学。 

 

实验指导 2-1： 

示波器 1 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开电路文件 Scope1.ms11。 

 

 

练习 

1. 计算信号的峰峰值。 
 

 

 

 

Vout (p-p) = ____________V  
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2. 计算信号周期。 
 

 

 

 

T = _____________ = ______________秒或________________毫秒 

 

3. 确定 V/Div 控件的设置，使波形大约显示为四格（垂直），但正弦波峰值不要超过显示 

出的上限或下限（正弦波峰值不应是截断的，也不应是平坦的）。 

 

 

 

 

要求的 V/DIV 设置 = ___________________ 

 

4. 确定时基控件的设置，以显示出大约两个周期的波形（水平）。 

 

 

 

 

要求的时基设置 = ______________毫秒/格 
 

5. 将示波器控制控件设置成计算出的值，然后点击电源开关或从菜单中选择 Simulate»Run 开

始电路仿真。确认该设置是否给出了要求的显示内容。 

 

注： 要实现最精确的测量，请点击 Pause（暂停）键来冻结波形。 

 

6. 周期测量方法：格数 x 峰间时长或交点间时长。 

 

T1 = ____________ 

 

T2 = ____________ 

 

周期 (T2 - T1) = ______________ 

 

频率计算值（Hz） = _________ 
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7. 测量峰峰值 

 

正峰电压 = ____________ 

 

负峰电压 = ____________ 

 

峰间电压 = ____________ 

 

8. 确认测量结果是否（在合理范围内）符合原理图上的值。 

 

9. 对任何可能在实际的频率、幅值与其实测量值之间造成差异的因素进行说明和解释。 

 

 

 

 

 

10. 双击交流电源查看其设置。注意其下方的电压幅值设置及电压 RMS 设置。试着改变幅值

设置并观察由此产生的 RMS 电压。 
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实验指导 2-2： 

示波器 2 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 Scope2.ms11。 
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练习 

1. 利用电源开关求解电路。 

 

2. 为了得到最佳的观察结果和最精确的设置，请点击 Pause（暂停）键以冻结示波器窗口中

的波形。分析初始屏显： 

a) 要实现精确的测量，我们应当增加（每格显示时间更多）还是减少（每格显示时间更

少）“时基”设置呢？将您的选择解释给学员听。 

 

 

 

 

 

b) V/Div 的设置应当增加（每格显示电压值更大）还是减少（每格显示电压值更小）

呢？将您的选择解释 给学员听。 

 

 

 

 

 

c) 要能看到信号幅值的峰值，应当先调节哪个控制控件？将您的选择解释给学员听。 

 

 

 

 

 

3. 调节 V/Div 设置，直至能看到信号峰值，且屏幕上至少显示了三格信号。 

 

4. 记录 V/Div 设置。 
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5. 调节时基设置，直至显示了大约两个完整的周期。 

a) 记录时基设置。 

 

 

 

 

 

b) 利用该屏显确定信号的幅值及周期。从测得的周期来计算信号频率。展示所有的实测

值和计算值。 
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实验指导 2-3： 

用示波器测量幅值与相移 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 
打开文件 Scope3.ms11。 

 

 

注 

 电路中已包含了一个可变电阻。通过它，您可以更改 R的值，以展示截止频率或相移的变

化情况。 

 所示阻抗值是可变范围的最大值。可变分量的默认设置是最大值的 50%。  

 要更改阻抗值，请按下 A 键（增加值）或 SHIFT-A（减少值）。您也可以将鼠标移动到可

变 电阻上方并拖动出现的滑块。  

 另外，此类电路中还有一个可变电容器和电感器可供使用。 
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练习 

1. 求解电路。 

 

注： 示波器设置提供的波形显示周期一定不能超过两个周期（这是为了保证精确度）。 
 

2. 确定输入和输出幅度的比率，以及各波形上两个对应点之间的时差比率。时间参考可以使

用波形峰值时间点，也可以使用各波形穿过零位线的时间点。 

 

 

 

 

3. 输入与输出波型对应点之间的时差（利用相邻波峰点）： 

 

a) T1 - T2 = ___________ 

 

b) 波形周期 = ____________ 

 

c) 相移 = __________X 360 = ___________ 度 

 

4. 该输出是超前还是滞后于同相输入？解释给学员听。 
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实验指导 2-4： 

低通滤波器 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 Scope3.ms11。 

 

注 

 该电路的输出从 10Hz或以下起大约等于输入（如：在 5%以内），直至达到某个频率；然

后，输出开始下降（电路的衰减开始增加）。 

练习 

1. 双击打开波特图绘制器。  

2. 根据响应曲线确定以下内容： 

a) 当输出降至输入的 95%（近似值）时，输出与输入的比率为______________。 

b) 出现该情况时的频率为______________Hz。 
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c) 选填项 - 将输入与输出的比率转换为分贝表示法。展示计算结果。 

 

 

在______________Hz，衰减为______________dB 

 

3. 输出是在什么频率下降至输入的 70.7%（近似值）的？ 

a) 频率= ______________Hz 

 

b) 选填项 - 将该比率转换为分贝表示法。展示计算结果。请注意，这是-3dB 或截止频

率。 

 

 

 

 

在______________Hz，衰减为______________dB。 

 

4. 输出是在什么频率下降至输入的 10%（近似值）的？ 

a) 频率= ______________Hz 

 

b) 选填项 - 将该比率转换为分贝表示法。展示计算结果。 

 

 

 

 

在______________Hz，衰减为______________dB。 

 

5. 在不做计算的情况下，解释输出随着频率的增加而减少的原因。 

 

 

 

 

 

6. 将波特屏显改为“PHASE”，以前面测量确定的频率测量相移（超前还是滞后）。 

a) 当输出为 95%时，相移 = ______________度。 

 

b) 当输出为 70.7%时，相移 = ______________度。 

 

c) 当输出为 10%时，相移 = ______________度。 

 

7. 双击打开示波器。观察波形。频率为 200 Hz。 

 

示波器上测得的幅值为__________V。 
 

8. 双击函数发生器。将频率改为 2,000 Hz。 
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示波器上测得的幅值为__________V。 

 

9. 将函数发生器的频率改为 20 kHz。示波器上测得的幅值为__________V。 

 

请注意三个读数之间的幅值差异。这是您预期的结果吗？解释给学员听。 
 

 

NI ELVIS 练习 

开始 
1. 打开文件 Scope3.ms11。  

2. 制作电路，如下图所示。  
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练习 

1. 执行仿真程序。将函数发生器设置为 100Hz。调节电位器值，并观察示波器。您看到了什

么变化？解释给学员听。 

 

 

 

 

2. 在 NI ELVIS 模型板上设置电路。运行函数发生器和示波器。调节电位器，并观察变化。 

就经验数据和仿真数据之间的任何差异进行解释和说明。 
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实验指导 2-5： 

串联谐振电路作滤波器用 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 Filter1.ms11、Filter2.ms11、Filter3.ms11 或 Filter4.ms11。 

练习 

1. 双击打开波特图绘制器窗口。 

 

2. 将波特图坐标设置为： 

 垂直：LIN, F = 1, I =0 

 水平：LIN, F = 50 kHz, I=1 kHz。 

 

3. 这是哪种滤波器响应？请圈选其中一项： 

 高通 

 低通 

 带通 

 带阻 
 

4. 测量响应曲线峰值处的谐振频率及电压增益。 

Fo = ____________kHz 

 

电压增益 = ____________ 

 

5. 测量电压增益减少至增益峰值约 70%(-3dB)时的频率。 

f1 (Fo 以上) = ___________kHz 

 

f2 (Fo 以下) = ___________kHz 

 

6. 这两个频率（滤波器带宽）之间的差距是多少？ 

带宽 = ___________kHz 
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观测结论： 

1. 所有电路的谐振频率和带宽（近似值）之间有什么关系？ 

 

 

 

 

2. 该比率与带通及带阻电路的电压增益相比有何不同？ 
 

 

 

 

NI ELVIS 练习 

开始 
1. 在您的 NI ELVIS 试验电路板上创建电路 Filter2.ms11。电路的输入就是函数发生器的输 

出，电路的输出取自运算放大器的输出引脚。  

 

 
 

注 
 您正在创建一个有源高通滤波器。这意味着，高频率正在无衰减地通过电路，低频率

则有所衰减。 
 

练习 
1. 创建好电路后，在 NI ELVIS 中运行波特分析仪。然后，打开 Filter2.ms11 并运行该仿真程 

序。将仿真的波特分析结果与您的波特分析仪提供的结果进行对比。 
 

 

 

 

2. 该高通滤波器的终止频率是多少？ 
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3. 要增加或减少终止频率，您会如何更改电路？ 

 

 

 

 
 

 

 





 

 

 

第 3 节：二极管  

章节内容 

本节含有以下内容： 

 “介绍二极管”（第 3-2 页）。 

本节实验指导 

本节所含实验指导始于“实验指导 3-1：削波器”的第 1 页。 

 

 “实验指导 3-1：削波器” 

 “实验指导 3-2：钳位器” 

 “实验指导 3-3：带 LabVIEW 元件的钳位器” 

 “实验指导 3-4：桥式整流器及齐纳二极管” 

 “实验指导 3-5：IV 曲线”。 

本节电路 

下面列出了本节所用电路的名称，以及每个电路的简要描述。 
 
文件（.ms11） 描述 
BridgeRectifierWFilter 带滤波器的桥式整流器。 
Clamper1 供学员研究用的两个钳位电路。 
Clamper2 
ClamperLabView 

供学员研究用的两个钳位电路。 

采用了 LabVIEW 仪器的两个钳位电路。 
Clipper1 有待学员分析的三个削波电路。 
Clipper1TS 有故障的三个 Clipper1 削波电路。 
ClipperApplications 削波电路的两种实际应用。 
IV 利用 Multisim 的 IV 分析仪对二极管的 I 和 V 进行对应分析。 
Transducer 该电路探索了不同的传感器。 
Zener 该文件带有两个齐纳电路供学员分析。 
ZenerTS 一个类似于 Zener.ms11 的文件，但含有一个故障。 

 



3-2  Multisim 之实用教学理念 
 

 

介绍二极管 

掌握良好的半导体设备知识对成功开展电子学教育而言至关重要。理解二极管的工作原理和

各种用途是深入学习先进设备的基本条件。  

 

在学员试着理解晶体管理论时，多花一点时间给他们提供大量的二极管实例供他们分析，这

种做法会很有收获。如果学员完全理解了二极管处于正向或反向偏置时的工作状态，以及可

以利用这种情况的各种电路，初步的准备工作就算是做好了。 

 

本节介绍五种削波器、四种钳位器、一种桥式整流器及两种齐纳电路。削波器所在电路文件

为：Clipper1.ms11 和 ClipperApplications.ms11。 

 

钳位器所在电路文件为：Clamper1.ms11 和 Clamper2.ms11。每个文件中含有两个电路。文件 

BridgeRectifierWFilter.ms11 中含有一个输出为波纹直流的滤波器。齐纳二极管文件 Zener.ms11

中含有两个电路文件。 

前提 

 学员应当已经了解了半导体理论、削波器、钳位器和整流。 

 学员须能够在 Multisim 环境下使用万用表和示波器。 
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实验指导 3-1： 

削波器 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 Clipper1.ms11。 

 

练习 

1. 利用您对削波器工作原理的理解，绘制期望的波形，并标示出每个关键点（峰值和直流电

平）. 

2. 点击开关或选择 Simulate»Run 来执行仿真程序。 

3. 双击示波器以查看其显示波型。 
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4. 绘制输出，然后对比您在第 1步中得出的结果。用心理解并解释造成差异的任何可能的原

因。 

5. 打开文件 ClipperApplications.ms11。 

 

 
 

6. 分析各电路，理解其工作原理。 

 

7. 执行仿真程序并观察结果。 
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NI ELVIS 练习 

开始 
在您的 NI ELVIS 试验电路板上创建出您在文件Clipper1.ms11中模拟并研究过的三个电路。下 

图给出了创建此类电路的实例。 
 

 
 

Clipper1.ms11 中的前两个电路除直流电压外完全相同。其中一个的直流电压为+2 V，另一个则

为-2 V。上方是构建此类电路的一个实例。 
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Clipper1.ms11 所含三个电路中的最后一个电路如上图所示。一个 10kΩ的电阻代替了仿真中使

用的那个 10Ω电阻。  

在您的试验电路板上创建 ClipperApplications.ms11 文件中的两个削波应用电路。同样，您可以

参考下图。打开 ClipperAplications.ms11 并执行仿真程序，这样，您就得到了一个有用的参考

对象，也能更好地理解电路的功能原理了。 

 

 
 

在上方的实例中，模拟输出 0 和模拟输出 1 用于生成电路的交流及直流信号。 
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对于上方所示的削波应用 Circuit B（电路 B），模拟输出 0 用于产生交流信号，模拟输出 1 用

于产生正的直 流电压信号，可变电源则用于生成负的直流电压信号。 
 

注 
 在创建这些 NI ELVIS 电路的过程中，您可以尝试用不同的方法在您的试验电路板上 

创建电路。例如，用模拟输出（DAC 0/1）或函数发生器来生成输入交流信号。另 

外，直流电压可以在 模拟输出上生成，也可以从可变电源那里生成。尝试使用这些不

同的方 式来让您的电路正常工作。 

练习 

1. 利用您在课堂上学到的二极管理论来分析上方的每种电路。 

 

2. 利用 NI ELVIS 及其仿真程序来对比您的物理试验结果。 

 

3. 既然您已经创建了五种二极管电路，那么，您还能想到更多的应用吗？考虑各种不同的输

入信号，以及您可能会从中得到的输出。 
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实验指导 3-2： 

钳位器 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 
打开文件 Clamper1.ms11。 

 

 
 

练习 

1. 利用您对钳位器的理解，通过阅读对应的说明框，绘制出期望的波形，并标示出每个关键

点（峰值及直流电平）。 
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2. 点击开关或选择 Simulate»Run 来执行仿真程序。 

3. 双击示波器以查看其显示波型。 

4. 绘制输出，然后对比您在第 1步中得出的结果。用心理解并解释造成差异的任何可能的原

因。 

5. 打开文件 Clamper2.ms11。 

 

 

6. 重复步骤 1-4。 

 

 

 

 

 

NI ELVIS 练习 

开始 
在您的 NI ELVIS 试验电路板上创建出您在文件 Clamper1.ms11 中仿真并研究过的两个电路。

下 图列举了创建此类电路的实例。打开 Clamper1.ms11 并执行仿真程序，这样，您就得到了一

个有 用的参考对象，也能更好地理解电路的功能原理了。 

 

注 
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 在下列 NI ELVIS 电路执行过程中，您可以尝试用不同的方法在您的试验电路板上创 

建电路。例如，用模拟输出（DAC 0/1）或函数发生器来生成输入交流信号。另外， 

直流电压可以在模拟输出上生成，也可以从可变电源那里生成。尝试使用这些不同的

方式来让您的电路正常工作。 

 在您操作这些钳位电路时，请牢记：电容元件可能会逐渐增强并带电，从而影响电路

的性能。试验过程中，可能有必要将电容器接地，以释放其带有的电压。 
 

 
 

Clamper1.ms11 中的第一个电路有正直流电压，第二个电路有负直流电压。上述过程使用模拟

输出 1 来生成电路的直流值。 

 

现在，在您的试验电路板上创建文件 Clamper2.ms11 中的两个钳位电路。同样，您可以参考下

图。打开 Clamper2.ms11 并执行仿真程序，这样，您就得到了一个有用的参考对象，也能更好

地理解电路的功能原理了。 

 
 

Clamper2.ms11 中的第一个电路有正直流电压，第二个电路有负直流电压。上述过程使用模拟

输出 1 来生成电路的直流值。  
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练习 

1. 利用您在课堂上学到的二极管理论来分析上方的每种电路。 
 

2. 利用 NI ELVIS 及其仿真程序来对比您的物理实验结果。 

 

3. 您能想到钳位电路的任何具体应用吗？ 
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实验指导 3-3： 

带 LabVIEW 元件的钳位器 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 ClamperLabView.ms11。 

 

 

练习 

1. 绘制各电路的期望波形，标示出每个关键点（峰值及直流电平）。 
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2. 执行仿真程序。对于 Circuit A（电路 A），请双击 LabVIEW 信号分析仪，然后选择 time 

domain signal（时域信号）作为其分析类型。对于 Circuit B（电路 B），请双击示波器来 

查看您的信号。验证您从练习 1 中预期的输出。 
 

3. 从 Circuit A（电路 A）的 LabVIEW 信号分析仪中选择 auto power spectrum（自动功率 

谱）。您在窗口中看到的是分贝值和频率，或“谱”。检查所示信号频率是否与钳位器输

入相同。要查看窗口的不同部分，您可以纵向或横向（朝任一方向）移动显示波型。具体

方法：选择右下角的指针，一边点击鼠标左键，一边在窗口上移动指针。 

 

4. 将 Circuit B（电路 B）中 LabVIEW 发生器的频率改为 500 Hz，然后重复练习 1 和 2。 

 



  第1页，共 2 页 

 

 

© 2010 National Instruments Corporation. 允许复制本页用于课堂教学。 

 

 

 

 

实验指导 3-4： 

桥式整流器及齐纳二极管 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 BridgeRectifierWFilter.ms11。 

 

 
 

练习 

1. 利用您学习过的整流器理论分析电路。 

2. 绘制期望的滤波器输出，并标示出每个关键点。 

3. 执行仿真程序，然后对比您第 2 步的结果。 



第2页，共 2 页  实验指导 3-4 

 

 

© 2010 National Instruments Corporation. 允许复制本页用于课堂教学。 

 
 

 

 

4. 打开文件 Zener.ms11。 

 

 
 

 

5. 假定 Vz = 10 V，请检查每个齐纳二极管是在拐点以上还是以下运行。 

 

Vo1 = 

 

Vo2 = 

 

6. 用一个 200 ohm的电阻取代 B 部分里的并联电阻，方法：双击电阻并更改它的值。重新计

算 并判断齐纳二极管是在拐点以上还是以下运行。 

 

 

 

Vo2 = 
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实验指导 3-5： 

IV 曲线 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 IV.ms11。 

 

 
 

练习 

1. 根据您掌握的理论绘制出期望的二极管曲线。 
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2. 双击打开示波器。按下任务栏右侧的开关，或从菜单中选择 Simulate»Run 来执行仿真程

序。现在，您正在观察硅二极管的特性。 

3. 按下窗口底部的红色箭头，直至蓝色垂直 Marker（标记器）出现。将 Marker（标记器） 

拖至二极管开始导电的位置。注意窗口左下方显示的电压。Vf = ________________ 

4. 假定 delta Rf = delta V/ delta I，或 V1 - V2 / I1 - I2，测量曲线上任意两点的电压和电流，

以 此计算出 Rf。利用窗口底部显示的电压和电流。 

传感器 

目标  

让学员熟悉 Multisim 的两种传感器。研究 LED 及温控电阻的特性。 

注释 

传感器可见于“杂项”零件组：传感器系列。 

流程 

1. 打开 Transducer.ms11。 

 

 
 

2. 打开说明框并完成各步骤。 

3. 点击开关，或选择 Simulate»Run 来执行仿真程序。 
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挑战课题 

三个电路文件含有故障，并以字母“TS”来表示。要观察这些故障，请取消 Options/Circuit 

Restrictions/General 标签下对隐藏元件故障复选框的选择，然后双击元件和电源。设置密码可以防

止学员访问。使用说明框的目的是指导学员完成故障排除过程。 

 

故障排除文件为 Clamper1TS.ms11、Clipper1TS.ms11 和 ZenerTS.ms11。 

 

NI ELVIS 练习 

开始 
在您的 NI ELVIS 试验电路板上创建出您在文件 IV.ms11 中模拟并研究过的二极管电路。下图

是 一个电路实例。打开 IV.ms11 并执行仿真程序，这样，您就得到了一个有用的参考对象，也

能更好地理解电路的功能原理了。 

 

 
 

上方电路中使用了模拟输出 0（DAC 0）来生成交流输入信号。ACH0 用于测量二极管两端的

电压，ACH1 则用于测量穿过二极管的电流。 
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练习 

1. 利用您在课堂上学到的二极管理论来分析上方的电路。 
 

2. 利用 NI ELVIS 及其模拟电路输出来对比您的物理实验结果。 

 

 

 



 

 

第 4 节：晶体管 

章节内容 

本节含有以下内容： 

 “介绍双极晶体管”（第 4-2 页） 

 “场效应晶体管特性：漏极与跨导”（第 4-4 页） 

本节实验指导 

本节所含实验指导始于“实验指导 4-1：基极接地电路”的第 1 页。 

 

 “实验指导 4-1：基极接地电路” 

 “实验指导 4-2：射极跟随器” 

 “实验指导 4-3：具有无旁路电阻的共射极电路” 

 “实验指导 4-4：两级晶体管放大器” 

 “实验指导 4-5：测量结型场效应晶体管的特性” 

 “实验指导 4-6：结型场效应晶体管特性的动态测量” 

 “实验指导 4-7：结型场效应晶体管跨导的动态测量” 

 “实验指导 4-8：双极结型晶体管共射放大电路向导” 

 “实验指导 4-9：双极结型晶体管两级放大电路向导” 

本节电路 

下面列出了本节所用电路的名称，以及每个电路的简要描述。 
 
文件（.ms11）  描述 
CommonBase 基极接地电路特性研究。 

CommonCollector 射极跟随器特性研究，包括阻抗特性。 

CommonEmitter 共射极电路特性研究。 

CommonEmitterTS, 
TSA, TSB 

带故障的共射极电路。 

FETCurve1 逐点地测量和绘制结型场效应晶体管的漏极特性。 

FETCurve2 利用示波器以动态方式显示结型场效应晶体管的漏极特性曲线。 

FETTransconductance 利用示波器以动态方式显示结型场效应晶体管的跨导曲线。 

TwoStageAmplifier 两级晶体管放大器的研究。利用 Multisim 的页外连接符功能研究增 益、工作电压及最大无畸

变输出，以便在单独的页面上单独分析各级的特性。 
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介绍双极晶体管 

本节含有双极结型晶体管（BJT）及场效应晶体管（FET）的电路文件和实验指导。重点将是

对各种电路的分析，以及它们与仿真值的比较。本节鼓励学员在整个电路上执行各种测量。

本节提供了一个无旁路电阻的共射极电路供学员实验用，以探索增益和阻抗之间的折衷关

系。 

 

此外，实验指导还附带了一个两级放大器，该放大器存放在说明框中，也可以打印出来。故

障电路亦有提供。 

前提 

我们假定学员已经掌握了晶体管电路的求解方法，包括交流和直流分析，以及阻抗特性。 

注释 

 用所给的万用表测量任何相关的电压或电流。双击打开万用表窗口。 

 双击交流电源以增加其电压。 
 

 

图 4-1：CommonBase.ms11 
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相关实验指导 

 “实验指导 4-1：基极接地电路” 

 “实验指导 4-2：射极跟随器” 

 “实验指导 4-3：射极无旁路电阻共射电路” 

 “实验指导 4-4：两级放大器” 

 

概念扩展 

1. 这个两级放大器用于第 5节的故障排除。 

2. 文件 FETCurve1.ms11、FETCurve2.ms11 和 FETTransconductance.ms11 演示了利用 Multisim 

绘制结型场效应晶体管特性曲线的方法。 

3. FETCurve1.ms11 演示了手工绘制（逐点）结型场效应晶体管一系列漏极特性曲线的方法。 

4. FETCurve2.ms11 演示了利用示波器绘制漏极特性动态曲线的方法。 

5. FETTransconductance.ms11 演示了利用示波器绘制结型场效应晶体管跨导动态曲线的方

法。 

6. 这三个文件所演示的原理可以扩展至几乎任何其他的有源设备。 
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场效应晶体管特性：漏极与跨导 

目标 

了解场效应晶体管的工作原理。 

前提 

您需要用到以下电路文件： 
 FETCurve1.ms11 

 FETCurve2.ms11 

 FETTransconductance.ms11. 

注释 

您可以用任何其他场效应晶体管取代这些练习中的晶体管。您也可以在“编辑模型”窗口中 

更改场效应晶体管特性。 

相关实验指导 

 “实验指导 4-5：测量结型场效应晶体管的特性” 

 “实验指导 4-6：结型场效应晶体管特性的动态测量” 

 “实验指导 4-7：结型场效应晶体管跨导的动态测量” 

挑战课题 

三个电路文件含有故障，并以字母“TS”来表示。要观察这些故障，请取消 Options»Circuit 

Restrictions»General 标签下对隐藏元件故障复选框的选择，然后双击元件和电源。设置密码可以 

禁止学员访问故障元件。说明框用于指导学员完成整个故障排除过程。下一节将进一步鼓励

学员加强解题逻辑。 
 

故障排除文件为 CommonEmitterTS.ms11、CommonEmitterTSA.ms11 和 

CommonEmitterTSB.ms11。 
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实验指导 4-1： 

基极接地电路 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 CommonBase.ms11。 

 

 
 

注 

 用所给的万用表测量任何相关的电压或电流。 

 双击打开万用表窗口。 
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练习 

1. 计算 IE。 

 

 

 

2. 假定 alpha ＝ 0.95 计算 IC。 

 

 

 

 

 

 

 

3. 计算穿过 RC、VRC 的电压。 

 

 

 

 

 

 

 

4. 计算 VC。 

 

 

 

 

 

 

 

5. 执行仿真程序，并利用万用表读数对比第 1 至第 4步的计算值。 

 

该电流探头发挥着钳式电流探头的作用，它可以将流经电缆的电流转换成探头输出端的电 

压。在这个基极接地电路中，探头输出端连接了万用表。如需使用，请将万用表设置为 V， 

然后用“1V/mA”的转换比率读取输出（单位：安培）。 



实验指导 4-1  第3页，共 4 页 

 

 

© 2010 National Instruments Corporation. 允许复制本页用于课堂教学。 

 
 

IE = 

 

IC = 

 

VRC = 

 

VC = 

 

 

 

 

6. 观察输出波形。电压增益是多少？您预期的电压增益是多少？请记住，基极接地电路结构

是针对高电压增益的情况而使用。 

 

 

 

 

 

Av = 

 

7. 计算最高无削波输入电压。更改输入电压以体现该电压，然后执行仿真程序来验证您的结

果。 

 

 

NI ELVIS 练习 

开始 
在您的 NI ELVIS 试验电路板上构建 CommonBase.ms11 所示电路。如果您没有某个电阻、电容 

器或电压源，请更改文件以反映您可用的值。例如：+12V 的电压源可以用 +15V 的直流电源 

来代替。-3V 的电压源可以由可变电源来提供，交流电源可以由函数发生器来提供。  

 

 

注 
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 请务必使用 NI ELVIS DMM 的电流输入。您每次只能在您的电路中使用一个 DMM。 

 

练习 

1. 您的仿真值与您在 NI ELVIS 上利用 DMM 和示波器测得的值相比有何不同？   
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实验指导 4-2： 

射极跟随器 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 CommonCollector.ms11。 

 

 

注 

 用所给的万用表测量任何相关的电压或电流。 

 双击打开万用表窗口。 

 双击交流电源以增加其电压。 
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练习 

1. 您预计该电路会出现增益还是衰减？ 

 

 

 

 

 

2. 该电路表现出了哪些理想的特性？ 

 

 

 

 

 

3. 假定 Beta = 100，计算基极电流。 

 

 

 

 

 

4. 计算射极电流。 

 

 

 

 

 

5. 计算射极电压。 
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6. 打开输入端的频率计，方法：双击它并留意工作频率。  

 

您预计放大器的输出频率会改变还是保持不变？ 

 

用输出频率计检查您的结果。 

 

7. 计算 Av。 

 

 

 

 

 

8. 执行仿真程序并用给出的万用表和示波器读数对比计算结果。 

 

NI ELVIS 练习 

开始 
将函数发生器作为交流电源，在您的 NI ELVIS 试验电路板上创建 CommonCollector.ms11 中模 

拟过的电路。ELVIS 上没有明确的频率计，但示波器提供了频率测量值。    

 

 

注 

 将 NI ELVIS 函数发生器用作交流电源时，回忆 Vrms与正弦波幅值之间的关系，Vrms = 

1/√2 A。NI ELVIS 函数发生器的软前面板利用幅值来说明正弦波的幅度，但 Multisim 

电路使用的是 Vrms。   

 图中，使用了两个 1µF 的电容器来代替一个 2µF 电容器。 
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练习 

1. 运行仿真电路，对比示波器的测量值与 NI ELVIS 示波器的测量值。频率和幅值相比有何 

不同？   
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实验指导 4-3： 

射极无旁路电阻共射电路 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 CommonEmitter.ms11。 
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练习 

1. 对于 Circuit A（电路 A），假设 Beta ＝ 100 计算 VC。 

 

 

 

 

 

2. 计算电压增益 Av。 

 

 

 

 

 

3. 计算最高无削波输入电压。 

 

 

 

 

 

4. 执行仿真程序并对比检查您的结果。 

5. 双击 RE1，将它的值增加到 1 kohm。执行仿真程序。 

a) 电压增益是多少？ 
 

 

 

 

 

b) 计算输入阻抗。 
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6. 移除无旁路射极电阻 RE1，用短路电阻代替它，方法：鼠标左键点击电阻（高亮显示）， 

然后按下键盘上的删除键。用鼠标连接发射极与 RE。 

 

 

 

 

 

 

 

 

7. 计算最高无削波输入电压。执行仿真程序。增加输入，方法：双击交流电源并更改它的 

值。（每次改值时必须停止模拟）。最高无削波输入电压是多少？ 

 

 

 

 

 

 

 

 

8. 无旁路射极电阻与电压增益之间有联系吗？如果有，请说明。 

 

 

 

 

 

 

 

 

9. 您为什么认为无旁路电阻在共射极电路中会比较理想？其“折衷”过程是怎样的？ 

 

 

 

 

 

 

 

 

10. 打开 Circuit B（电路 B）的 IV 分析仪。执行仿真程序。您看到了什么？ 
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11. 利用电流探头找到 IC。该电流探头发挥着钳式电流探头的作用，它可以将流经电缆的电流 

转换成探头输出端的电压。探头输出端连接着示波器。读取示波器上的直流电压电平，将

其作为电流 IC，转换比率为 1V/mA。  

 

 

NI ELVIS 练习 

开始 
更改 CommonEmitter.ms11 中的 Circuit A（电路 A），用一个 2 kohm 的电位器代替 RE1。   

 

 
 

练习 

1. 执行仿真程序，改变电位器的电阻。用示波器查看您先前在对电阻 RE1 进行短路处理时 

观察到的饱和状态。在 NI ELVIS 上构建同样的电路，并在更改电位器的同时用 NI ELVIS 

示波器查看输出。将仿真程序和实际电路实验数据进行对比。   

 

2. 您能看出无旁路射极电阻值与电压增益之间的关系吗？它是否符合上方练习 8 中得到的关

系？  
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实验指导 4-4： 

两级晶体管放大器 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 
 

打开文件 TwoStageAmplifier.ms11。 

 

 
 

将有两个文件被打开。其中一个文件含有第一级，其说明框中另有多个练习，第二个文件中

含有第二级。这两级将由一个页外连接符连接起来。 

 

 

 

注 
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该练习演示了如何用“三步”学习法学习更复杂的电路。它强调了将理论、软件仿真及“真

实世界”的结果相关联的重要性，包括理想元件与有公差的真实元件之间的差异。 

 

学员须有完整分析多级晶体管放大器的经验，包括直流偏压、交流输入阻抗及电压增益（也

可能包括频率响应）。 

 

该电路在第 5 节中以带故障的形式再次出现，以便在故障排除方面进一步提供实用的练习，

因为这方面仅靠理论是不足以解决问题的。 

练习 

测量该放大器的下列运行特性。请说明所测量的项目，并展示任何计算结果。该电路还附带

了一个参照该流程的实验指导。 
 

1. 确定 20 mV(p-p) 输入对应的输出电压： 

 

Vout = V(p-p) 或 V(RMS) 

 

2. 测量放大器的电压增益： 
 

电压比：电压增益 = 

 

以分贝表示法表示：  

 

电压增益 =  

 

3. 输出在多少输入幅值上正好开始畸变（削波）？ 

 

 

 

 

 

4. 找出不会畸变的最大允许输入值。 
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5. 测量并记录电路中每个点的所有直流及交流电压。您可以将它们记录在纸上或说明框中，

或利用 Place»Text 命令直接记录在电路图上。 

 

 

 

 

 

 

 

 

6. 打开 Circuit B（电路 B）的 IV 分析仪。执行仿真程序。您看到了什么？ 

 

 

 

 

 

 

 

 

注： 您可以利用这些读数对第 5 节中的电路进行故障排除。 
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实验指导 4-5： 

测量结型场效应晶体管的特性 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 FETCurve1.ms11。 

 

 
 

注 

加入这两个电位器是为了协助调节栅极偏压 Vgs 以及漏极与源级之间的电压 Vds。 

 按下 R 将增加栅极到源极的偏压（向负方向增加），按下 SHIFT-R 会将 Vgs 朝着 0V 方向

减少。您也可以将鼠标移至电位器上并拖动出现的滑块。 

 按下 D 将减少 Vds，按下 SHIFT-D 将增加 Vds。 

 依靠电位器的设置下可能无法获得准确的电压。但是几毫伏的误差不会对结果造成很大影

响。 
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练习 

1. 绘制漏极特性曲线： 

a) Idss = _______________mA 

 

b) 注意栅级电流 Ig。Ig = 

 

结果可观吗，可以约计为零吗？ 

 

2. 将 Vgs 设置为 0V，将 Vds 设置为 12V，然后测量漏极电流。讨论那些影响选择场效应晶 

体管而非双极结型晶体管的特性。将具有无旁路电阻共射电路和射极跟随器电路结构纳入

您的讨论内容。  

 

 

 

 

 

 

3. 针对下列各表中的每个 Vgs 值，将 Vds 设置成给定值，然后测量并记录漏极电流 Id。 

 

Vgs = - 6 

Vds 1.0 V 2.0 V 3.0 V 5.0 V 9.0 V 12.0 V 

Id       

 

 

Vgs = - 4 

Vds 1.0 V 2.0 V 3.0 V 5.0 V 9.0 V 12.0 V 

Id       

 

 

Vgs = - 2 

Vds 1.0 V 2.0 V 3.0 V 5.0 V 9.0 V 12.0 V 

Id       

 

 

Vgs = - 1 

Vds 1.0 V 2.0 V 3.0 V 5.0 V 9.0 V 12.0 V 

Id       

 

 

Vgs = 0 

Vds 1.0 V 2.0 V 3.0 V 5.0 V 9.0 V 12.0 V 

Id       

 

 
 

4. 将结果绘制在合适的线性图纸上，对比课本中提供的结果，对曲线形状进行讨论。 
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5. 根据实测结果绘制出该结型场效应晶体管的跨导曲线图。 
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实验指导 4-6： 

结型场效应晶体管特性的动态测量 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 FETCurve2.ms11。 
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注 

 利用电位器，我们可以更改栅偏压 Vgs。按下 R 键将增加栅极与源极之间的偏压（向负方

向增加），按下 SHIFT-R 会将 Vgs 朝着 0V 方向减少。您也可以将鼠标移至电位器上并拖

动出现的滑块。  

 使用电位器进行设置可能无法获得准确的电压。但是几毫伏的误差不会对结果造成很大影

响。  

 绘制曲线时，漏极电压显示于水平轴上，漏极电流（由穿过 1 ohm 电阻的电压读出）显

示于垂直轴上。（穿过 1 ohm 电阻的每毫伏电压的电流灵敏度为 1mA。）每个 Vgs 值都

有绘制一条曲线。 

练习 

1. 绘制动态漏极特性曲线： 

a) 将 Vgs 设置为零，将 Vds 设置为 12V。观察该 Vgs 值的漏极特性曲线。对比理想曲线 

（来自课本或根据文件 FETCurve1.ms11 绘制而成的结果），对该曲线的形状进行评 

述。 

 

 

 

 

 

b) 更改 Vgs 并再次测量。如果您已经测量过了 FETCurve1.ms11 中的值，请对比该动态曲 

线及所绘曲线上指定的点。 
 

 

 

 

 

2. 就此项研究的结果写一篇简短的报告。 
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NI ELVIS 练习 

开始 
在您的 NI ELVIS 试验电路板上构建 FETCurve2.ms11 所示电路。电路的输入来自可变电源及

函 数发生器。输出与示波器的两个通道均有连接。  

 

 

注 

 NI ELVIS 函数发生器最高可输出 2.5 Vpp。 

练习 

1. 在观察 NI ELVIS 示波器两个通道的同时，用电位器更改 Vgs。描述实验观察结果与模拟

结果的对比情况。 

2. 利用 NI ELVIS 上的两线制电流电压分析仪来绘制漏极特性曲线。绘制曲线时，您需要断

开 电路与示波器及函数发生器的连接。将晶体管漏极连接至 DMM 的电流 hi 输入，将晶

体管 源极连接至电流 lo输入。此类连接的详情见 NI ELVIS 帮助文件。将结果与 

Multisim 中绘制的仿真曲线进行对比。  
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实验指导 4-7： 

结型场效应晶体管跨导的动态测量 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 FETTransconductance.ms11。 
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注 

 利用电位器，我们可以更改漏源电压 Vds。按下 D键将增加栅极与源极之间的偏压（负电

压方向增加），按下 SHIFT-D 会将 Vds 朝着 0V 方向减少。您也可以将鼠标移至电位器上

并拖动出现的滑块。 

 使用电位器进行设置下可能无法获得准确的电压。但是几毫伏的误差不会对结果造成很大

影响。 

 绘制曲线时，栅源电压（Vgs）可以将绘制于水平轴上，漏极电流（由穿过 1 ohm 电阻的

电压 读出）将绘制于垂直轴上。（穿过 1 ohm 电阻的每毫伏电压的电流灵敏度为 

1mA。）为每一个不同的 Vds 值各绘制一条曲线。 

练习 

1. 绘制动态跨导特性曲线： 

a) 将 Vds 设置为 12V，并观察该 Vds 值的跨导特性曲线。对比理想曲线（来自课本或根 

据文件 FETCurve1.ms11 绘制而成的结果），对该曲线的形状进行评述。 

 

 

 

 

 

b) 将来自该曲线的 Idss 值与得自 FETCurve1.ms11 或 FETCurve2.ms11 的值进行对比和讨

论。 

 

 

 

 

 

c) 更改 Vds 并再次测量。如果您已经测量过了 FETCurve1.ms11 中的值，请对比该动态曲 

线及所绘曲线上特定的点。 

 

 

 

 

 

2. 就此项研究的结果写一篇简短的报告。 
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NI ELVIS 练习 

开始 
打开 FETTransconductance.ms11 并在您的 NI ELVIS 试验电路板上构建电路。函数发生器及可

变电源是电路的输入，示波器的两个通道用于对比函数发生器的输入与漏极电流。 

 

 

练习 

1. 在观察 NI ELVIS 示波器两个通道的同时，用电位器更改 Vds。将您的观察结果与仿真结

果进行对比和讨论。 

 

2. 利用 NI ELVIS 上的两线制电流电压分析仪来绘制漏极特性曲线。绘制曲线时，您需要断

开 电路与示波器及函数发生器的连接。将晶体管栅极连接至 DMM 的电流 hi 输入端，将

晶体管 源极连接至电流 lo 输入端。此类连接的详情见 NI ELVIS 帮助文件。将结果与 

Multisim 中绘制的仿真曲线进行对比。  
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实验指导 4-8： 

双极结型晶体管共射放大电路向导 

姓名：__________________________ ID 号：___________________ 班级：________________ 

开始 

打开文件 BJT CE Wizard.ms11。 
 

练习 

1. 选择 Tools»Circuit Wizards»CE BJT Amplifier Wizard。以 125 的增益构建一个一级放大器，

VCC = 10V，输入频率为 1 kHz。验证您的电路参数，然后构建电路。 

 

 

 

2. 将电路值调整为真实元件的值，同时将增益保持在 125 的 10%以内。双击各元件以更改它

的值。 

 

 

 

3. 对您的放大器设计方案的局限性/优势进行评述。 

 

 

 

4. 计算允许的最高无削波输入电压。  
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实验指导 4-9： 

双极结型晶体管两级放大电路向导 

姓名：__________________________ ID 号：___________________ 班级：___________ 

开始 

打开文件 BJT 2 Stage Wizard.ms11。 
 

 

练习 

1. 选择 Tools»Circuit Wizards»CE BJT Amplifier Wizard。以 VCC = 15V 及 1 kHz 的输入频率构建 

一个两级放大器。每个放大器的增益应为 100。用 125 进行测试。验证您的电路参数，然

后构建每个电路。 
 

 

 

2. 将电路值调整为真实元件的值，同时将增益保持在要求之增益的 10%以内。双击各元件以

更改它的值。 

 

 

 

3. 对您的放大器设计方案的局限性/优势进行评述。 

 

 

 

4. 计算允许的最高无削波输入电压。 
 

 

 

5. 重新计算允许的最高无削波输入电压。 
 

 

 

6. 共射极设计方案中为什么要加入无旁路电阻？它对电路有何影响？ 





 

 

第 5 节：故障排除及解决 

章节内容 

本节含有以下内容： 

 “仿真环境中的真实挑战”（第 5-3 页） 

 “故障排除工作”（第 5-4 页） 

 “测验：运用知识来思考”（第 5-5 页） 

 “故障解决技巧”（第 5-6 页） 

 “故障解决与设计之间的联系”（第 5-8 页） 

本节的故障排除工作及实验指导 

本节的故障排除工作及实验指导始于实验指导“故障排除工作 5-1：串联电阻”的第 1 页。 

 

 “故障排除工作 5-1：串联电阻” 

 “故障排除工作 5-2：直流电路 2” 

 “故障排除工作 5-3：直流电路 3” 

 “故障排除工作 5-4：NPN，分压器偏置” 

 “故障排除工作 5-5：NPN 部分旁路射极电路”  

 “故障排除工作 5-6：共基极电路配置”  

 “故障排除工作 5-7：排除两级放大器的故障”  

 “故障排除工作 5-8：黑匣子问题 1、2” 。 

本节电路 

下面列出了本节所用电路的名称，以及每个电路的简要描述。 
  
文件（.ms11）  描述 
CommonBaseTS 排除晶体管设置故障，以确定其工作区域。 
Puzzle1–6 黑匣子问题。通过测量来判断匣子内的元件。 
SeriesParallel2 串并联电路的故障排除。 
SeriesParallel3 串并联电路的故障排除。 
TroubleShooting1 用欧姆计排除串联电路的故障。 
TroubleShooting2 晶体管分压器偏压问题。 
TroubleShooting3 晶体管放大器问题。 
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TroubleShooting4 两级晶体管放大器（分压器偏压，部分旁路的共发射极电路）。 

 
Files for practice finding faults: 
GateFaults 单个 IC 门电路的故障。 
GateFaults2 集成电路中的故障。 
Troubleshooting2A NPN 分压器偏置电路中的故障。 
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仿真环境中的实际挑战 

在学习电子学的第一年里，学员要完成许多艰巨的任务。他们必须具备充足的数学能力才能

应用一些陌生的概念。他们必须学习电子学的理论知识，并熟悉各种相关仪器。 

 

学员通常是通过自己遇到的错误来认识故障排除。这可能会让他们感到迷惑，尤其是当相关

的基本理论还尚未理解吸收的时候。常常有大量的时间用于介绍各种概念以及应对损坏的元

件和设备，因此，故障排除概念可能只能得到很短的时间（如果需要介绍的话）。对学员和

讲师来说，这都是一件令人沮丧的事情。 

 

利用 Multisim 讲授故障排除概念是完美的求解方案。有了 Multisim，您可以利用自己设计的 

故障或程序中提供的故障来创建电路。使用 Multisim 的故障时，您可以通过设置密码的方式 

来禁止学员访问这些故障。 

 

此外，您也可以通过创建和锁定子电路的方式来隐藏故障。您可以指导学员，让他们利用说

明框来查出故障。然后，学员可以通过可用的元件和电源来排除故障。 

 

利用动态测量探头可以快速测量电压电平。通过 Multisim 的电子表格功能，学员可以看到所 

有元件的全部选定特性。此外，学员也可以通过电子表格本身来操纵和使用所有这些特性。  

 

最后，您会看到自己的学员正在培养成一种逻辑思维模式。除了作为学员教育的一个重要环

节外，故障排除也是一个可以让学员获得自信心的途径，因为他们自然而然地扩展了理论知

识并掌握了电子学。 

 

该介绍部分之后有几个故障排除练习可以帮助您开好这个头。其中许多练习来自美国国家仪

器 （NI）有限公司出版的《Troubleshooting with Electronics Workbench》一书（直接选取或稍

加修改而成的电路）。这些文件已经取消了密码，以便您研究那些引入电路中的故障。不

过，在您与学员一起使用这些文件之前，您应当设置自己的密码。 
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故障排除工作 

目标 

让学员获得电路故障排除方面的经验。 

前提 

您需要用到以下文件： 

 TroubleShooting1.ms11 – TroubleShooting4.ms11 

 SeriesParallel2.ms11 

 SeriesParallel3.ms11 

 CommonBaseTS.ms11. 

 

学员应该已经： 

 对基本的串并联电路、晶体管特性及电压放大器有一定的了解 

 对反馈电路特性有一定的了解。 

相关的故障排除工作 

 “故障排除工作 5-1：串联电阻” 

 “故障排除工作 5-2：直流电路 2” 

 “故障排除工作 5-3：直流电路 3” 

 “故障排除工作 5-4：NPN，分压器偏置” 

 “故障排除工作 5-5：NPN 部分旁路发射极电路”  

 “故障排除工作 5-6：共基极电路配置”  

 “故障排除工作 5-7：排除两级放大器的故障”  
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测验：运用知识来思考 

解决故障的最佳方式 

电子学的教学工作通常加入了课本中的故障来加强各种电子学概念。许多情况下，重点在于

“复杂计算”、或者遵守课本中的即定流程以及一些实验流程方面。Multisim 使讲师能够更

加 灵活的开展教学。 

 

利用 Multisim，您可以创建测验，以此来增强学员解读由电路（或设备）得到的读数和数值

的能力， 而此类电路或设备通常并没有提供完整的信息。“评估黑匣子的行为”要求学员选

择并明智地调节测试设备，解读读数、应用基本的理论知识，最重要的是，进行大量的思考

和故障解决工作。 

 

与故障排除练习相似的是，这些可能会包括在老师的审查下，设置密码限制对一些部件或模

型的访问。我们已经取消了文件的密码，以便您了解黑匣子的内部情况。不过，您需要给此

类电路文件添加自己的密码，然后再与学员一起使用文件。要添加密码，请点击

Options»Circuit Restrictions 下面的 Password（密码）键。 

 

您可以通过创建和锁定子电路的方式来创建新的测验。如果原文件在网络上有受到保护，那

么，这些黑匣子测验便具有了某种优势。学员可以将原文件拷贝到他们的磁盘上，然后解 

题，并将其求解方案记录在说明框中，然后将磁盘交给讲师进行评估。或者，他们可以将其

含有求解方案的文件拷贝到另一个目录下，供以后进行参考。 

 

随着学生们对解答黑匣子越来越有信心的时候，建议可以将那些无法用现有信息及/或设备解

决的问题包括在内。当学员有信心对您说某道题解不出来时，概念将在他们的头脑中得以巩

固。 

测验实例 

电路文件 Puzzle1.ms11 至 Puzzle6.ms11 中提供了六道黑匣子测验题实例。 

下面几页或是文件的说明框中给出了对解题有所帮助的提示、实验指导样本及推荐方法。 
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故障解决技巧 

目标 

练习故障解决技巧及思考问题的能力。 

前提 

您需要用到电路文件 Puzzle1.ms11 和 Puzzle2.ms11。  

学员需要熟悉 RC、RL 及 RLC 电路在交流条件下的行为，包括幅值频率响应及相位频率响

应。 

注释 

这里的每个黑匣子都是一个子电路（如前所述），作为一个独立的元器件工作。在

Puzzle1.ms11 中，黑匣子的行为和单个电容器一样；在 Puzzle2.ms11 中则和电感器一样。 

流程 

1. 打开文件 Puzzle1.ms11 或 Puzzle2.ms11。 

 

 

图 5-1：Puzzle1.ms11 
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图 5-2：Puzzle2.ms11 

2. 全班以“头脑风暴”的方式讨论出可以采用的解题策略。此处的目标是得到一个问题解决

的策略近似于后面的“黑匣子测验”实验指导所推荐的策略。 

3. 设计该实验指导是为了配合两道测验题（单独使用或者是一起使用）。如果您已经得到了

一种足够接近的解题方法，那么，可以将其中一个黑匣子问题布置给学员们作答。给学员

分发实验指导，指导他们在解题的同时完成实验指导。 

相关实验指导 

“故障排除工作 5-8：黑匣子测验 1、2” 。 
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故障解决与设计之间的联系 

目标 

练习故障解决技巧及思考问题的能力。 

前提 

您需要用到电路文件 Puzzle3.ms11 和 Puzzle6.ms11。 

我们假定学员已经掌握了函数发生器和电压表的使用方法，包括选择电压表的交流或直流功

能。 

 

 

图 5-3：Puzzle3.ms11 
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概念扩展 

在剩余的三道题中，学员将被告知黑匣子的元件，而不知道它们的连接结构。学员需要判断

排布结构，然后利用提供的元器件构建一个电路，使其行为与黑匣子的行为相同。学员可以

将测验题保存在磁盘上，然后交给讲师进行评估。 

 

我们建议您在 Puzzle4 至 Puzzle6 中禁止学员访问元件（见 Options»Circuit Restrictions» 

Toolbars）。学员只能使用“试验电路板”上提供的元件。三道测验题如下所示： 

 

 
 

图 5-4：Puzzle4.ms11 
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图 5-5：Puzzle5.ms11 

 

 

图 5-6：Puzzle6.ms11 

参考 

主题 参考 
示波器 Multisim 帮助文件 

说明框 Multisim 帮助文件 

密码 教师专用的 Multisim：Ch. 1 “教师指南” 

限制 教师专用的 Multisim：Ch. 1 “教师指南” 
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故障排除工作 5-1： 

串联电阻 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 
打开 TroubleShooting1.ms11。 

 

注 

总电阻 RT = 1.75 kohm（正常工作）。 

建议 

 测量总串联电阻。 

 将实测的 RT 值与正确的值进行对比。 

 故障可以立即确定吗？也就是说，两者的差异是否等于原理图所示电阻数值中的任一

值？）如果是，请检查那个可疑的电阻（或多个电阻，如果相同的值有不止一个。） 

 如果故障不明显，请逐个检查每个电阻。 

 用提供的备用件更换故障电阻，并检查电路电阻是否正常。 

 

注 

  

本报告中，并不需要测量所有的数据。良好的故障排除流程意味着，您只需要读取刚

好够用的读数来找出问题所在。完成后，用提供的备用件更换故障元件，并检查电路

是否运行正常即可。 
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故障排除报告 

1. 初步故障表现： 

 

 

2. 读取之后用于查出故障的读数： 
 

R1 = 

 

R2 = 

 

R3 = 

 

R4 = 

 

R5 = 

 

故障电阻是 
 

维修结果 RT  
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故障排除工作 5-2： 

直流电路 2 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 SeriesParallel2.ms11。 
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练习 

1. 求解电路。（利用电源开关。） 

2. 描述故障。 

 

 

 

 

 

3. 描述可能导致所观察到问题的故障可能性。 
 

 

 

 

 

4. 更换可疑的元件，解决问题并检查运行是否正常。 

提示：您只有三个备用保险丝。结果如何？ 

 

 

 

 

 

5. 继续排除电路故障。简要描述步骤及结果。 

 

 

 

 

 

6. 解决方法是什么？ 
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故障排除工作 5-3： 

直流电路 3 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开 SeriesParallel3.ms11。 

 

 
 

注 
 该电路显示了正确的电压和电流，与使用手册中的一样。 

 产品提供了一些备用零件，以便您更换故障元件并根据正确的“使用手册”值来检查运行

情况。 

 故障可能是开路、短路或元件值错误。 
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练习 

1. 启动电路，检查工作电压及电流。分析结果，以尽可能少的测量次数来查出故障。不要随

意更换零部件。 

 

描述您的方法，包括测量方法以及下一次测量的理由。 

a)  

b)  

c)  

d)  

e)  

f)  

g)  

 

2. 描述故障。 

 

 

 

 

 

3. 更换故障元件，并检查电路是否运行正常。 
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故障排除工作 5-4： 

NPN，分压器偏置 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开 TroubleShooting2.ms11。 

 

 
 

注 

 良好的故障排除流程需要在每次测量之后都进行思考。 

 记住，下方要求的测量任务并不一定都是必要的。 
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练习 

1. 描述用于在该电路中找出故障的流程。直流测量： 

 

VCC = 

 

VC = 

 

VB = 

 

VE = 

 

VCE = 

 

VBE = 

 

2. 哪些测量结果看上去表明了故障元件？解释给学员听。 

 

3. 下一步是什么？ 

 

 

 

 

结果： 
 

4. 因此，故障元件是： 

 

 

 

 

5. 更换故障元件，并检查电路是否运行正常。维修结果满意吗？ 

 

 

 

 

6.哪几个测量是必要的？ 
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故障排除工作 5-5： 

NPN 部分旁路发射极电路 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 
打开 TroubleShooting3.ms11。 

 

 

注 
 直流电压由“V”表示，交流电压由“v”（p-p）表示。 

 故障可能是以下原因造成的：电容器值发生改变，由于电阻数值出错或是晶体管电流增益

剧烈变化导致偏置状态的变化。 

 记住，移除交流输入和检查直流偏置状况的做法常常很有帮助。  

 记住良好的故障排除方法，试着用尽可能少的测量次数来诊断故障。 
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练习 

1. 描述用于发现故障的流程： 

 a) 交流测量结果： 

Vout =      Vc = 

 

Vb =      Ve = 

 

 b) 直流测量结果：  

Vc =      VB = 

 

VE1 =      VE2 = 

 

VBE =      VCE = 

 

2. 故障有可能是（如果明显的话）： 

 

3. 下一次测量将是： 

 

 结果： 

4. 执行更多测量（如果必要的话）。 

5. 故障元件是： 

 
 
 
 
6. 更换故障元件，并检查运行是否正常。维修结果满意吗？ 
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故障排除工作 5-6： 

共基极电路配置 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开 CommonBaseTS.ms11。 

 

 
 

 

注 

 晶体管应该工作于线性区域内才能使电路正确工作。 
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建议 

 测量示波器的输出电压。 

 测量射极与基极之间的电压。 

 如果故障不明显，请检查集电极与基极之间的电压。 

 更换引起故障的元件及/或电源。 

 

注  本报告中，并不需要测量所有的数据。良好的故障排除流程意味着，您只需要读取刚

好够用的读数来找出问题所在。完成后，用提供的备用件更换故障元件，并检查电路

是否运行正常即可。 

练习 

1. 计算 IE。 

2. 使用 alpha ＝ 0.90 计算 IC。 

3. 计算 RC 两端的电压 VRC。 

 



故障排除活动 5-6  第3页，共 4 页 

 

 

© 2010 National Instruments Corporation. 允许复制本页用于课堂教学。 

 

4. 计算 VC。 

5. 执行仿真程序，并利用万用表对比第 1 至第 4 步。 

 

IC = 

IE = 

VRC = 

VC = 

6. 这些值与您的理论分析结果相比有何不同？该电路有问题吗？如果有，是什么问题？ 

 

7. 测量基极与射极之间的电压。 

 

VBE = 

8. 测量基极与集电极之间的电压。  

 

VBC = 
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9. 晶体管是在什么区域工作？ 

10. 为什么？ 

11.  要让晶体管在线性区域内工作，您会如何修改该电路？ 
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故障排除工作 5-7： 

排除两级放大器的故障 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 TroubleShooting4.ms11。  

 

 

注 
 总电压增益（近似值）= 115。 

 低 3dB 频率点 = 100 Hz。 

 如果输入电压 Vin 为 20mv (p-p)，且频率为 1000 Hz，Vout 则为 2.3v (p-p)。 

 直流电压由“V”表示，交流电压由“v”（p-p）表示。 
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建议 

 故障可能是以下原因造成的：电容器值发生改变，由于电阻数值出错或晶体管电流增益剧

烈变化导致偏置状态变化。 

 记住，移除交流输入和检查直流偏置状态的做法常常很有帮助。 

 记住良好的故障排除方法，试着用尽可能少的测量次数来诊断故障。 

练习 

1. 在您查出电路故障元件的同时，对流程、测量结果及结论进行描述。 

 

 a) 

 

 b) 

 

 c) 

 

 d) 

 

 e) 

总结报告 
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故障排除工作 5-8： 

黑匣子测验 1、2 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 Puzzle1.ms11 或 Puzzle2.ms11。 

 

 

练习 

1. 将信号发生器设定在某个频率和幅值上。（试着从 1 kHz 和 10 v 峰值上启动。） 

2. 观察示波器通道 A 和 B 上的输入及输出电压。 

3. 将一个电阻（负载电阻）连接到输出端（建议的电阻值从 1K 开始）。 
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4. 调节发生器频率或负载电阻值，使输出幅值明显区别于输入值。 

5. 相移为未知元件的特性提供了线索： 

无相移表示它是电阻性的。 

相移超前表示它是电容性的。 

相移滞后表示它是电感性的。 
 

测量结果： 

负载电阻值_________________________ 
 

频率_______________________________ 
 

输入幅值___________________________ 
 

输出幅值__________________________ 
 

是否存在相移？______________________________ 
 

是否需要更改电阻值？_______________ 
 

新值_______________________________ 
 

6. 如有变化： 

输入幅值___________________________ 
 

输出幅值__________________________ 
 

是否存在相移？______________________________ 
 

超前还是滞后？________________________ 

 

7. 未知的是（圈选一项）： 

电阻性 

电容性 

电感性 
 

8. 展示您用于确定未知元件值的计算过程： 

 

 



 

 

 

第 6 节：运算放大器 

章节内容 

本节含有以下内容： 

 “介绍运算放大器”（第 6-2 页）。 

本节实验指导 

本节的实验指导始于“实验指导 6-1：运算放大器研究 1：反相交流放大器”的第 1 页： 

 

 “实验指导 6-1：运算放大器研究 1：反相交流放大器” 

 “实验指导 6-2：运算放大器研究 2：同相交流放大器” 

 “实验指导 6-3：有源带通滤波器” 

 “实验指导 6-4：串联旁路稳压器” 

 “实验指导 6-5：积分器” 

 “实验指导 6-5：相移谐振电路” 

 “实验指导 6-5：脉宽调制器” 

本节电路 

下面列出了本节所用电路的名称，以及每个电路的简要描述。 
 

  
文件（.ms11）  描述 
ActiveBandPassFilter 有源带通滤波器。 
Integrator 积分电路。 
InvertingAmplifier 反相运算放大器电路的交流运行。 
NonInvertingAmplifier 同相运算放大器电路的交流运行。 
PhaseShiftOscillator 相移谐振电路。 
PWM  脉宽调制电路。 
SeriesPassVoltageRegulator  带有运算放大器误差放大的线性串联旁路稳压器电路。 



6-2  Multisim 之实用教学理念 

 

 

介绍运算放大器 

本节所含练习旨在培养学员对运算放大器方面的兴趣。 

 

授课时可采用各种方式，具体视可用设施而定： 

 远程教育 

 用 PowerPoint 进行课堂演示 

 在软件实验室中进行教学。 

 

无论采用何种方式授课，这些练习都是为了促进对设备及电路行为的课内外讨论，以期给基

本理论赋予更多的实际意义。 

 

文件 Integrator.ms11、ActiveBandPassFilter.ms11、SeriesPassVoltageRegulator（带有运算放大器

误差放大的线性串联旁路稳压器电路）和 PWM.ms11（脉宽调制器）需要学员对运算放大器特

性有更加深入的了解，这些文件供后来的运算放大器应用课程使用。 

目标 

教您如何利用 Multisim 让学员熟悉运算放大器的基本工作原理。 

前提 

您需要用到以下电路文件： 
 InvertingAmplifier.ms11 

 NonInvertingAmplifier.ms11. 

 

学员须熟悉： 

 Multisim 中的测量工作，包括示波器和仪表的使用 

 运算放大器的基本理论。 

参考 

主题 参考 
波特图绘制器 Multisim 帮助文件 
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实验指导 6-1： 

运算放大器研究 1：反相交流放大器 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 InvertingAmplifier.ms11。 

 

 
 

练习 

1. 将输入设置为 0V（输入电位器设置为 0%），观察所有的交流电压和电流。与课本或理论 

进行对比。 
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2. 用 G 或 SHIFT-G 键选择一个新的输入电压值来更改原输入值，并再次观察。您也可以将指

针 移动到电位器上方并拖动出现的滑块。  

 

3. 检查：反相输入端与同相输入端之差乘以开环增益所得结果是否等于输出值。 

 

a) 反相输入端 =  

 

b) 同相输入端 =  

 

c) 差异 = 

 

d) 开换增益 = 

 

e) 计算结果 = 

 

f) 实测输出值 = 

 

4. 用示波器或波特图绘制器找出上、下截止（或转折）频率。 

 

a) 上截止频率= 

 

b) 下截止频率 = 

 

5. 增加输入幅值，直至出现输出削波。对比最大输出峰峰值与电源电压。 

 

a) 最大输出峰峰值 = 

 

b) 电源电压 = 
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NI ELVIS 练习 

开始 
在 Multisim 中打开文件InvertingAmplifier.ms11。 在您的 NI ELVIS 试验电路板上创建电路，如 

下图所示。 

 

 

注 

 用 NI ELVIS 硬件上的函数发生器来控制输入电路的正弦波的频率和幅值。 
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练习 

1. 在 Multisim 中： 

a) 将可变电阻 R1 设置为 0Ω，观察所有交流电压和电流。与课本或理论进行对比。 
 

 

 

b) 用G或SHIFT-G键选择一个新的 R1 值来更改原输入值，并再次观察。您也可以将指针

移动到电位器上方并拖动出现的滑块。  

 

 

 

2. 在构建于 NI ELVIS 中的电路上，增加并减少 R1 的电阻。您观察到了什么？  

 

 

 

3. 检查：反相输入端与同相输入端之差乘以开环增益所得结果是否等于输出值。 

 

 模拟值 实测值 

反相输入端 
  

同相输入端 
  

差值 
  

开换增益 
  

计算结果 
  

实测输出值 
  

 

4. 用示波器或波特图绘制器找出上、下截止（-3dB）频率。 

 
频率 模拟值 实测值 

上截止频率 
  

下截止频率 
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实验指导 6-2：运算放大器研究 2： 

同相交流放大器 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 NonInvertingAmplifier.ms11。 
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练习 

1. 将输入设置为 0V（输入电位器设置为 0%），观察所有的交流电压和电流。与课本或理论 

进行对比。 

 

对比： 
 

 

 

 

 

2. 用 G 或 SHIFT-G 键选择一个新的输入电压值来更改原输入值，并再次观察。您也可以将指

针 移动到电位器上方并拖动出现的滑块。 

 

 

 

 

 

 

 

对比： 
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3. 检查：反相输入与同相输入之差乘以开环增益所得结果是否等于输出值。 

 

反相输入端 =  

 

同相输入端 =  

 

差异 = 

 

 

开换增益 = 

 

计算结果 = 

 

实测输出值 = 
 

4. 用示波器或波特图绘制器找出上、下截止（或转折）频率。 

 

上截止频率= 

 

下截止频率 = 
 

5. 增加输入幅值，直至出现输出削波。对比最大输出峰峰值与电源电压。 

 

最大输出峰峰值 = 

 

电源电压 = 
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实验指导 6-3： 

有源带通滤波器 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 ActiveBandPassFilter.ms11。 

 

 
 

设计信息来源于 Winzer 所著的《Linear Integrated Circuits》一书。 
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练习 

1. 用波特图绘制器判断电路的增益和带宽。 

 

2. 利用合适的设计信息设计一个中心频率为 4.7kHz，品质因数 Q 值为 4 的滤波器。 
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NI ELVIS 练习 

开始 
在您的 NI ELVIS 试验电路板上创建出您在文件 ActiveBandPassFilter.ms11 中模拟并研究过的带

通滤波器电路。下图是一次执行实例。打开 ActiveBandPassFilter.ms11 并执行仿真程序，这

样，您就得到了一个有用的参考对象，也能更好地理解电路的功能原理了。 

 

 
 

在上方所示电路中，ACH0 用于测量输出电压，而 ACH1 用于测量输入电压。两个通道的负

极管脚均有接地。NI ELVIS 波特分析仪接收这两个模拟信号之后，在输入端（FUNC OUT）

生 成所需信号，由此绘制出电路的波特图。 

练习 

1. 利用您在课堂上学到的运算放大器理论来分析上方的电路。 

 

2. 将您使用 NI ELVIS 得到的实际运行结果与仿真电路的输出进行对比。 
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实验指导 6-4： 

串联旁路稳压器 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 SeriesPassVoltageRegulator.ms11。 

 

 

注 
 原始电源由一个 20 V 的蓄电池构成，同时用一个串联交流电源来模拟 120 Hz 的全波波纹 

（电压峰峰值约为 3 V）。 

 负载电流用 L 或 SHIFT-L 键来更改。 

 经调节稳压后的输出电压用 R 或 SHIFT-R 键来更改。您也可以将指针移动到电位器上方并

拖动出现 的滑块。 
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练习 

1. 让调压电位器处于中间位置（50%），计算预期的输出电压。 

 

 

 

 

 

2. 让调压及负载电位器处于中间位置（50%），测量输出电压、电流及波纹。 

 

 

 

 

 

3. 将输出电压调整位于 6 V 左右，根据负载电流绘制输出电压及波纹曲线（负载电阻变化步

长为 10%）。 

 

 

 

 

 

4. 根据实测结果，计算电路的电压调整率。 

 

 

 

 

 

5. 根据实测结果，计算电路的波纹电压抑制率。 

 

 

 

 

 

6. 在最大负载电流状态下，降低输入电压，直至输出调节作用消失。（让波纹保持不变）。

记录该值。 

 
 
 
 
 

7. 用其他类型的晶体管做实验，以研究晶体管特性对电路性能的影响。汇报您的研究结果。 
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实验指导 6-5： 

积分器 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 Integrator.ms11。 

 

 

练习 

1. 假定电压峰峰值 = 20V，频率 = 1kHz，输出为三角波，计算输出电压（Vout）。 

 



第2页，共 2 页  实验指导 6-5 

 

 

© 2010 National Instruments Corporation. 允许复制本页用于课堂教学。 

 
 

2. 执行仿真程序，然后对比您得出的结果。 

 

 

 

NI ELVIS 练习 

开始 
在您的 NI ELVIS 试验电路板上创建出您在文件 Integrator.ms11 中模拟并研究过的积分电路。 

下图是一次执行实例。打开 Integrator.ms11 并执行仿真程序，这样，您就得到了一个有用的参

考对象，也能更好地理解电路的功能原理了。 

 

 
 

上方电路利用函数发生器（FUNC OUT）来生成幅值为 2 V 的 1 kHz 三角波输入信号。示波

器 通道 A 为电路输入端，通道 B 为输出端。A- 管脚和 B- 管脚均有接地。 

练习 

1. 利用您在课堂上学到的运算放大器理论来分析上方的电路。 
 

2. 将您使用 NI ELVIS 得到的实际运行结果与仿真电路的输出进行对比。 
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实验指导 6-6： 

相移振荡器 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 PhaseShiftOscillator.ms11。 

 

 

练习 

1. 执行仿真程序。请耐心等待。振荡过程要几秒钟后才会开始。 

2. 测量输出端的频率。 

3. 调节电位器，直至振荡开始。计算振荡开始点的 Rf/R 值。 

 

Rf/R = 
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实验指导 6-7： 

脉宽调制器 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 PWM.ms11。 

 

 
 

注 
 可以用作开关式稳压电源激励器。 

 电位器 S 代表采样直流电压（“误差”电压），脉宽随误差电压而变化。 

 环路增益用电位器 G 调节。 
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练习 

1. 所有电位器都置于 50%处开始仿真。观察输出脉宽和占空比。记录量值。 

 

电位器 S =    脉宽 =    占空比 = 
 

电位器 G =    脉宽 =    占空比 = 

 

电位器 R =    脉宽 =    占空比 = 

 

 

2. 用 S 或 SHIFT-S 键更改采样电压，观察脉宽和占空比所受影响。您也可以将指针移动到电

位 器上方并拖动出现的滑块。 

 

电位器 S =    脉宽 =    占空比 = 

 

电位器 G =    脉宽 =    占空比 = 

 

电位器 R =    脉宽 =    占空比 = 

 

 

3. 调节环路增益（20%左右），然后重复。对电路运行状况所受的影响进行评述。 

 

电位器 S =    脉宽 =    占空比 = 

 

电位器 G =    脉宽 =    占空比 = 

 

电位器 R =    脉宽 =    占空比 = 

 

 

 



 

 

 

第 7 节：晶闸管及开关 

章节内容 

本节含有以下内容： 

 “介绍晶闸管及开关”（第 7-2 页）。 

本节实验指导 

本节所含练习始于“实验指导 7-1：SCR：SCR 的简单电阻控制”的第 1 页。 

 

 “实验指导 7-1：SCR：SCR 的简单电阻控制” 

 “实验指导 7-2：研究 DIAC 特性” 

 “实验指导 7-3：SCR 与 DIAC” 

 “实验指导 7-4：用相移和 DIAC 控制 SCR” 

 “实验指导 7-5：电压控制开关（VCS）的应用” 

本节电路 

下面列出了本节所用电路的名称，以及每个电路的简要描述。 
 
文件（.ms11）  描述 
DiacCharacteristics DIAC 特性。 
PhaseShiftControl SCR 导通的相移控制。 
SCR1 熟悉 SCR（电阻控制）。 
SCRDiac 带 DIAC 的 SCR 电路。 
VoltageControlledSwitch 使用压控开关和 RC 电路组成张弛振荡器。 



7-2  Multisim 之实用教学理念 

 

 

 

介绍晶闸管及开关 

本节所含练习旨在培养学员对晶闸管及开关的兴趣。设计这些练习是为了向学员演示每个元

件的特性。 

 

授课时有多种形式可供选择，具体取决于课程要求及可用设施：  

 作为远程学习课程的一部分 

 利用投影仪进行课堂演示 

 用 PowerPoint 

 作为软件实验室。 

 

希望这些练习能够进一步培养学员对课题理论的兴趣。本节将介绍开关器件（如：SCR、

DIAC 及电压控制开关（VCS））的基本特性。此外，相移控制一小节也将在此节里进行介

绍。本节 共关联了五个.ms11 文件。 

目标 

介绍开关装置的基本特性，包括：SCR、DIAC、使用 SCR、DIAC 以及包括在 Multisim 元器件

列表中的 VCS 进行简单的交流电源相位控制。 

前提 

学员须： 

 熟悉 Multisim 以及利用示波器和仪表进行测量的方法（交流和直流）。（或见下方注释） 

 已经认识 SCR 及 DIAC 的基本理论。 

 熟悉 RC 电路中的时间常数和相移。 
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实验指导 7-1： 

SCR：SCR 的简单电阻性控制 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 SCR1.ms11。 

 

 

注 
 电位器 D 起“亮度”控制作用。  

 SCR 在导通时，灯管会发光。 
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练习 

1. 假定栅电压达到 1V 时 SCR 会启动（开始传导），假定亮度控制器设置为 25%（从滑动

接触端到 地之间的电阻为 250 欧姆），计算 SCR 将在交流电源波形的哪个点上启动。

（即，在多少度上？） 

 

2. 针对该情况，计算 SCR 的导通角。 

 

3. 将亮度控制器设置为 25%，然后求解电路。通过测量来确认在第 1、2 步中计算出的值。 

 

 

 

 

 

 

 

 

4. 找出导通角： 

a) 通过实验现象判断会让 SCR 完全导电（导通角 > 170 度）以及刚好会让 SCR 停止导电

的亮度控制器设置。 
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b) 通过计算来确认这些点是否与理论相符。 

 

 

 

 

 

 

 

 

5. 记录理想的 SCR 的 Vgt、Igt 和 Ih 值。 

 

 

 

 

 

 

 

 

6. 将电子管的功率定额改为 10W，将亮度控制器设置为 25%，然后求解电路。 

7. 解释 SCR 在电源电压达到零之前就停止导电（和之前一样）的原因。 

 

 

 

 

 

 

 

 

8. 将 SCR 从理想的型号改为 2N1599 型。求解电路，并解释为什么这个 SCR 的导通状态一

直持续到正半周结束为止。（检查模型值）。 

 

 

 

 

 

 

 

9. 选择一个不同的 SCR 并重复步骤 1-3。简要汇报此项研究的结果。 
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实验指导 7-2： 

调查 DIAC 特性 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 DiacCharacteristics.ms11。 

 

 
 

注 
 电位器 D 改变施加给 DIAC 的电压。 

 100 ohm 的电阻将通过 DIAC 的电流限制在安全的水平上。 
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练习 

1. 假定外部施加的电压达到 10V 时 DIAC 会启动（开始导通），假定输入控制器设置为 50%

（滑动接触端与地之间的电阻为 500 欧姆），计算 DIAC 将在交流电源波形的哪个点上启

动。（多少度？） 

 

2. 将输入控制器设置为 50%，然后求解电路。通过测量来确认在第 2 步中计算出的值。 

 

3. 改变输入。将 DIAC 停止导电时的输入电压记录下来。解释给学员听。  

 

4. 记录理想的 DIAC 的 Vs、Vtm 和 Ih 值（得自“编辑模型”窗口）。 
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实验指导 7-3： 

SCR 与 DIAC 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 SCRDiac.ms11。 
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注 

 电位器 A 是“亮度”控制器 

 SCR 导通时，灯管会发光。 

练习 

1. 假定：栅电压达到 1 V 时 SCR 会启动（开始传导），亮度控制器被设置为 50%（滑动接

触端与地之间的电阻为 2.5 千欧姆），DIAC 击穿电压为 10 V。请计算 SCR 将在交流电

源波形的哪个点上启动（即，在多少度？）。 

 

2. 针对该情况，计算 SCR 的导通角。 

 

3. 将亮度控制器设置为 50%，然后求解电路。通过测量来确认在第 2、3 步中计算出的值。 

 

 

 

 

 

 

 

4. 找出导通角： 

a) 通过实验现象判断会让 SCR 完全导电（导通角 > 170 度）以及刚好会让 SCR 停止导电

的亮度控制器设置。 
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b) 通过计算来确认这些点是否与理论相符。 
 

5. 记录理想的 SCR 的 Vgt、Igt 和 Ih 值（得自“编辑模型”窗口）。 

 

6. 将灯管的额定功率改为 10 W，将亮度控制器设置为 50%，然后求解电路。解释 SCR 在电

源 电压达到零之前就停止导电（和之前一样）的原因。 
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实验指导 7-4： 

用相移和 DIAC 控制 SCR 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 PhaseShiftControl.ms11。 

 

 

注 

 这个实验将告诉学员：相移和 DIAC 是如何让 SCR 实现更广的导通控制的。 

 电位器 D 是“亮度”控制器。 

 注意，SCR 在导通时，灯管会发光。 
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练习 

1. 假定：栅电压达到 1 V 时 SCR 会启动（开始传导），亮度控制器被设置为 50%（10K）， 

DIAC 击穿电压为 10 V。请计算 SCR 将在交流电源波形的哪个点上启动。（多少度？） 

 

2. 针对该情况，计算 SCR 的导通角。  

 

3. 将亮度控制器设置为 50%，然后求解电路。通过测量来确认在第 2、3 步中计算出的值。

（包括测量电压在电路 A 点处的相移。） 

 

4. 亮度控制器设置： 

a) 通过实验现象判断会让 SCR 完全导电（导通角 > 170 度）以及刚好会让 SCR 停止导电

的亮度控制器设置。 
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b) 通过计算来确认这些点是否与理论相符。  

 

5. 简要汇报此项研究的结果，包括：针对该电路对导通角的控制度大于简单型控制电路对导

通角的控制度一事给予解释。（见文件 SCR1.ms11 与 SCRDiac.ms11）。 
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实验指导 7-5： 

电压控制开关（VCS）的应用 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 VoltageControlledSwitch.ms11。 
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注 

 该电路可用于演示或研究 RC 时间常数。 

 这个电路使一个张弛振荡器，它模拟 555 定时器处于无稳态振荡器的运行。当电压为 10 V

（即 555 定时器的上阈值 2/3 Vcc）时，VCS 处于闭合状态；当电压为 5 V（即 555 定时器

的下阈值 1/3 Vcc）时，VCS 处于断开状态。 

练习 

1. 求解电路，测量电容器的充电与放电时间。 

 

2. 利用 RC 时间常数理论，将充电及放电时间与理论值进行对比。 

 

 

 

 

 

3. 如需额外研究，请双击 VCS 并设定 VCS 的阈值电压。 
 

 



 

 

第 8 节：数字电路 

章节内容 

本节含有以下内容： 

 “介绍数字电路”（第 8-2 页） 

 “555 定时器无稳态振荡器”（第 8-3 页） 

 异步计数器（第 8-4 页） 

 译码器（第 8-6 页） 

 采用分立元件的 BCD 同步计数器（第 8-8页） 

本节实验指导 

本节所含实验指导始于“实验指导 8-1：555 定时器无稳态振荡器”的第 1页 

 

 “实验指导 8-1：555 定时器无稳态振荡器” 

 “实验指导 8-2：数字电路实例 1” 

 “实验指导 8-3：数字电路实例 2” 

 “实验指导 8-4：数字电路实例 3” 

 “实验指导 8-5：数字电路实例 4” 

本节电路 

下面列出了本节所用电路的名称，以及每个电路的简要描述。 
 
文件（.ms11）  描述 
Dig1, Dig1A - C 组合逻辑电路，以及数字测试设备的渐进式介绍。 
555Astab 555 定时器作为无稳态振荡器。 
AsynchronCounter 一种采用了分立式 JK 触发器的异步计数器。 
SynchronCounter 一种采用了分立式 JK 触发器和逻辑门电路的同步计数器。 
Demultiplexer 一种 3-8 译码器。 
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介绍数字电路 

本节含有一系列文件（共 8 个），这些文件介绍了 Multisim 在运行数字电路方面的功能及特

点，并演示了 Multisim 所供数字测试设备的部分基本功能。 

 

电路 Dig1.ms11、Dig1A.ms11、Dig1B.ms11 及 Dig1C.ms11 都是同一个电路，只是以不同方式进

行了研究。该电路可用任何数字电路实例代替。该电路是一种组合逻辑电路，类似于《Digital 

Fundamentals》（Floyd, Ed.5）一文中给出的某个实例。该电路含有若干个用于监测特定函数

的限位开关。输入为低电平时，LED 指示灯会熄灭。输入处于高电平状态时，LED 指示灯会

亮起。在 Multisim 环境中，我们还可以选择用蜂鸣器代替 LED 指示灯。 

 

另外，电路文件 555Astab.ms11 中也有介绍 Multisim 555 定时器的使用方法。文件

AsynchronCounter.ms11 与 Demultiplexer.ms11 中提供了异步计数器和多路分配器的实例。 

 

这些文件均可用来让远程和传统模式下的学员熟悉各种现有的数字设备。通过它们，学员可

以得到实用的模拟实验室学习体验，这些经验应当通过使用传统实验室的形式来进行扩充。 

目标 

 使用 Multisim进行数字电路实验 

 介绍 Multisim 提供的各种数字设备 

 介绍并演示 Multisim提供的 555 定时器的使用方法。 

前提 

学员须事先已经了解以下数字电路理论： 

 与门、或门、真值表、触发器、同步及异步计数器、RC 时间常数，以及 555 定时器 

 Multisim 环境，包括万用表、示波器及各种元件的使用方法。 
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555 定时器无稳态振荡器 

 

 

图 8-1：555Astab.ms11 

相关实验指导 

“实验指导 8-1：555 定时器无稳态振荡器”。 
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异步计数器 

 该电路是一种采用了 JK 触发器的 4 位计数器 

 读数以十六进制和二进制显示 

 可以在逻辑分析仪上观测到时序图。 
 

 

图 8-2：AsynchronCounter.ms11 

流程 

1. 求解电路，并在逻辑分析仪上观察各个输出的时序图。特别注意，您需要对比时钟与四路

输出之间的时序关系。 
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参考 

 

主题  参考 
逻辑分析仪 Multisim 帮助文件 
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译码器 

 

图 8-3：Demultiplexer.ms11 

运行 

输入线路 G1 上的输入数据通过开关 A、B 和 C 的组合作选择性输出。 

74LS138N 作为译码器 

 开关 A、B与 C 选择由输入数字线路 G1 传送得到的输出 

 输出线路 0至 7 的逻辑状态示于数据 发光 LED 指示灯上。没有数据存在时，数据线通常

处于高 电平状态（在数据通信中称为空闲状态或传号状态） 

 输入数据源可以是手动输入或是来自根据开关 S位置确定的存储在字生成器中的序列 

 手动数据输入由开关 D 控制。 
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流程 

1. 打开文件 Demultiplexer.ms11。 

2. 用开关 S 选择手动数据输入。设定数据线，选择开关 A、B 和 C 来选择输出线路 5。 

3. 求解电路，操作手动数据开关 D 来更改数据状态，并观察数据线 5 上的 LED 指示灯。检

查：数据 LED 指示灯 5的状态是否与通过数据开关 D 输入的状态相符。 

4. 设定数据线，选择开关 A、B 和 C 来选择其他输出线路，然后确认出现的数据是否正确，

是否与数据开关 D 相符。 

5. 用开关 S 选择字发生器作为数据源。查看字生成器中的数据序列，在字生成器中选择循环

生成模式。这样可以提供恒定的数据流作为输入。 

6. 确认字发生器中的数据序列是否正确的出现在数据输出上。  

7. 改变字生成器中的数据序列，将这个序列发送至选定的输出，进行实验。 

8. 就此项研究的结果写一篇总结报告。 

相关实验指导 

 “实验指导 8-2：数字电路实例 1” 

 “实验指导 8-3：数字电路实例 2” 

 “实验指导 8-4：数字电路实例 3” 

 “实验指导 8-5：数字电路实例 4” 

 

 

参考 
 
主题 参考 
字发生器 Multisim 帮助文件 

逻辑变换器 Multisim 帮助文件 

布尔表达式 Multisim 帮助文件 

真值表 Multisim 帮助文件 
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采用分立元件的 BCD 同步计数器 

注释 

 用逻辑分析仪显示完整的时序图。 

 BCD 输出显示在七段数码管上。 

 

 

图 8-4：SynchronCounter.ms11 

流程 

1. 打开文件 SynchronCounter.ms11。 
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2. 求解电路，在逻辑分析仪上观察各个输出的时序图。特别注意，比较时钟和四个输出的时

序关系。 

 

 

图 8-5：逻辑分析仪 

参考 
 
主题 参考 
逻辑分析仪 Multisim 帮助文件 
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实验指导 8-1： 

555 定时器无稳态振荡器及向导 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 555Astab.ms11。 
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练习 

1. 针对所示电路，计算上阈值及下阈值。展示计算结果。 

 

V(ut) = 

 

V(lt) = 

 

 

2. 计算电容器从 V(lt) 充电至 V(ut) 所需的时间。展示计算结果。 

 

 

 

 

 

t1 = _____________sec. 

 

3. 计算电容器从 V(ut) 放电至 V(lt) 所需的时间。展示计算结果。 

 

 

 

 

 

t2 = _____________sec. 

 

4. 计算振荡频率。 

 

 

 

 

 

 

 

5. 计算输出波形的占空比。 

 

 

 

 

 

 

 

6. 将 R1 改为 33 kohm，重复上述第 1 至第 4 步中的计算过程。 
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7. 求解电路（使用电源开关），利用蜂鸣器的输入，大致估计振荡频率。（用秒表为十个周

期计时）。 

 

 

 

 

 

 

 

 

8. 记录频率。 

 

 

 

 

 

 

9. 用示波器观察输出端波形及以及定时电容 C两端的电压波形。 
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10. 测量所有计算过的参数。 

a) 哪个波形显示了上、下阈电压（输出端的波形还是定时电容 C两端的电压波形）？解

释给学员听。 

 

实测 V(lt) = 

 

V(ut) = 

 

 

b) 哪个波形显示了电容器的充电和放电时间（输出端的波形还是定时电容 C两端的电压

波形）？解释给学员听。 

 

实测 t1 = 

 

t2 = 

 

c) 实测振荡频率。展示计算结果。 

 

 

 

 

f (osc) = _____________ Hz 

 

d) 这与您在第 7步中粗略估计的值相比有何不同？ 

 

 

 

 

 

e) 实测占空比。展示计算结果。 

 

 

 

 

占空比 = ___________% 
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11. 将 R1 改为 33k 并重复测量 10 a) 至 10 d)。将测量和计算结果填入合适的地方。 

a) 实测 V(lt) = _________ v 

 

b) V(ut) = ___________ v 

 

c) 实测 t1 = _________ sec.t2 = ___________ sec. 

 

d) f (osc) = _____________ Hz 

 

e) 占空比 = ___________% 

 

12. 将 R1 改为 1k，用一个 10k 的电阻连接插脚 5（控制插脚）和地线。 

a) 预测频率和占空比所受的影响，并简要解释您的预测结果。 

 

频率将______________ 

 

解释： 

 

 

占空比将______________ 

 

解释： 

 

 

b) 求解电路，测量频率和占空比，然后与您的预测结果进行对比。如果差异较大，请进

行说明： 

 

频率_____________ Hz 

 

占空比 ___________% 

 

13. 在主菜单中选择 Tools»Circuit Wizards»555 Timer Wizard 。选择 Vs = 10V，频率 = 2 kHz。选 

择 Build Circuit（构建电路），并将您的电路放在工作区内。从仪器工具栏中选择一个示 

波器。 将示波器连接至 555 定时器的输出端，执行仿真程序，然后检查您的设置。 
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NI ELVIS 练习 

开始 
在您的 NI ELVIS 试验电路板上创建 555Astab.ms11 所示电路，如下所示。该电路展示了 555

定 时器无稳态振荡器的运行状态。 

 

 

练习 

1. 在 NI ELVIS 中运行示波器，然后打开 555Astab.ms11 并执行该仿真程序。比较您得到

的仿真结果以及 NI ELVIS 振荡器电路的结果。 

 

2. 您在电路输出端上看到的频率是多少？ 

 

3. 您在电路输出端上看到的幅值是多少？ 
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实验指导 8-2： 

数字电路实例 1 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 Dig1.ms11。 

 

 

注 

如果两个或以上 Tank 输入（A、B 或 C）处于高电平状态，告警指示灯应当会亮起。即，其

输出状态为高电平，或逻辑 1。要改变开关状态，请按下上方指示的键。如需声音告警，可将

压电蜂鸣器连接至输出端。  

电路计算 

手动计算真值表（利用开关控制逻辑输入）。 
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1. 该电路有三路输入。该电路有多少种可能的输入组合？ 

 

 

2. 用开关将所有可能的逻辑状态输入到 A、B 和 C 这三路输入，然后填写下方的真值表。 
A 
 

B C 告警？ 

    

    

    

    

    

    

    

    

    

    

    

    

    

 

写出该电路的布尔表达式，然后对比逻辑变换器提供的求解方案。 
 

NI ELVIS 练习 

开始 

在您的 NI ELVIS 试验电路板上创建出您在文件 Dig1.ms11 中模拟并研究过的逻辑电路。下图

是一次执行实例。打开 Dig1.ms11 并执行仿真程序，这样，您就得到了一个有用的参考对象，

也能更好地理解电路的功能原理了。 

 
 

上方电路有三路输入和一路输出，也是以物理方式执行 Dig1.ms11 的一个范例。这几路输入分

别以 Tank1、2 和 3 来表示，报警作为输出。在 NI ELVIS 中，Tank1、2 和 3 使用三个不同 的
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数字输入通道（如：DI 0、DI 1、DI 2），报警输出（DM74LS32: 插脚 8）被连接至可由用 

户配置的 LED 指示灯上（如：LED 0），以观察不同的逻辑状态。 

 

练习 

1. 任何布尔函数都可以只用与非门或只用或非门来表示，也可用与门、或门及非门的组合来

表示，因为这些电路在功能上都是完整的。在下表中说明如何只用与非门来分别代替非 

门、与门、或门及或非门。  

 
 绘制出门电路 绘制出与非门等效电路 

非门 

 

 

 

 

  

与门 

 

 

 

 

  

或门 

 

 

 

 

  

或非门 

 

 

 

 

  

 

2. 在下方空白处绘制一幅卡诺图，此图须与本实验指导电路评测一节第 2 步中的真值表相

符。  

 

 

 

 

 

 

 

 

 

3. 布尔方程说明了逻辑电路的时序关系。 
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实验指导 8-3： 

数字电路实例 2 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 Dig1A.ms11。 

 

 
 

注 

如果输入 A、B 或 C 中有任何两个（或以上）的输入处于高电平状态，报警指示灯应当会亮 

起。（即，其输出状态为高电平，或逻辑 1。）  
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电路计算 

使用逻辑变换器 

逻辑变换器向多达八路输入提供所有可能的逻辑状态，并说明了单路输出的状态。对于该电

路，只有三个输入是必要的。 
 

 

练习 

1. 求解电路，在打开的逻辑变换器中，选择（单击）第一个 Conversions（变换）按钮。这样

可以得到电路的真值表。请记录真值表中的求解结果。 

 
A 
 

B C 输出 

    

    

    

    

    

    

    

    

    

 

2. 选择（点击）第二个 Conversions（变换）键。这样会给出电路的布尔表达式 。请记录该

布尔表达式。 
 

 

 

 

 

 

 

 

3. 通过对电路进行逻辑分析的方式来确认逻辑变换器提供的答案是否正确。请在这里说明您

所做的一切。 
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真值表： 

 

 

 

 

 

 

 

 

 

 

 

布尔表达式： 
 





  第1页，共 4 页 

 

 

© 2010 National Instruments Corporation. 允许复制本页用于课堂教学。 

 

 

 

实验指导 8-4： 

数字电路实例 3 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 Dig1B.ms11。 

 

 
 

注 

如果输入 A、B 或 C 中有任何两个（或以上）的输入处于高电平状态，报警指示灯应当会亮 

起。（即，其输出状态为高电平，或逻辑 1。）  
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电路计算 

使用字发生器 

字生成器能够提供多达八个输入的所有可能逻辑状态，并且能够由一个数字输入“字”改变

为下一个字。您可以设置多达 15 个输入字，通过将 1或 0输入每一个位中，而不一定要按照

顺序。 

 

输入以三种方式提供： 

 单步 - 每“点击”一次单步窗口就输入一个。 

 单帧 - 15 种可能的输入被输入给电路，然后计算过程停止。 

 循环 - 输入持续地送入电路。在这个电路中，仅需要三个输入，因此将字生成器设置为

八种可能的顺序二进制组合。 

练习 

1. 求解电路。输入到电路的二进制字被突出显示。 

输出状态与输入相符吗？______ 
 

 

 

 

 

 

 

2. 将这些状况填入下方的真值表中。 

 

 

3. 选择（点击）STEP（单步）键。输入字变为第二种情况。 
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输入以单步方式通过了所有八种可能的数字状态，现在请填写该电路的真值表。 
 

A 
 

B C 输出 

    

    

    

    

    

    

    

    

    

 

4. 通过对电路进行逻辑分析的方式来确认逻辑变换器提供的答案是否正确。请在这里说明您

所做的一切。 

 

真值表 
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实验指导 8-5： 

数字电路实例 4 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 Dig1C.ms11。 

 

 

注 

如果输入 A、B 或 C 中有任何两个（或以上）的输入处于高电平状态，报警指示灯应当会亮 

起。（即，其输出状态为高电平，或逻辑 1。）  
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电路计算 

使用字发生器及逻辑分析仪 
字生成器能够提供多达八个输入的所有可能逻辑状态，并且能够由一个数字输入“字”改变

为下一个字。您可以设置多达 15 个输入字，通过将 1或 0输入每一个位中，而不一定要按照

顺序。 

 

逻辑分析仪是一个 8通道示波器，能够测量电路中多达八个点的波形。在本实验中，三个输

入显示在三个通道中，而输出显示在第四个通道中。 

练习 

1. 求解电路。 

a) 观察逻辑分析仪上的波形。点击 STEP（单步）键，以单步方式让各输入通过所有可能 

的条件。评述结果。 

 

 

 

 

 

 

b) 观察逻辑分析仪上的波形。点击 BURST（单帧）键。评述结果。 

 

 

 

 

 

 

c) 观察逻辑分析仪上的波形。点击 CYCLE（循环）键。评述结果。 

 

 

 

 

 

 

2. 从您的数字课本中选择一个相似的电路，利用测试设备以及 Dig1 系列电路文件中研究过

的方法来分析该电路。然后提交一份简要但完整的研究结果报告，包括电路及求解方案的

打印本。 



 

 

第 9 节：模数混合电路 

章节内容 

本节含有以下内容： 

 “介绍混合电路”（第 9-2 页） 

 “将模拟输入转换为数字输入及反向转换”（第 9-3 页） 

本节实验指导 

本节所含实验指导始于实验指导 9-1 的第 1 页： 

 “实验指导 9-1：模数转换（ADC）” 

 “实验指导 9-2：数模转换（DAC）”。 

本节电路 

下面列出了本节所用电路的名称，以及每个电路的简要描述。 
 
文件（.ms11） 描述 
ADC-DAC  一个完整的 A/D 及 D/A电路采样；重建正弦波。 
AnalogToDigital 
Converter 

模数转换器。 

 
DigitalToAnalog 
Converter 

数模转换器。 

 
 



9-2  Multisim 之实用教学理念 

 

 

 

 

介绍混合电路 

为了分析控制系统技术，学员必须接触模拟及数字电路的各种组合。Multisim 在模拟环境中 

提供此类组合。 

 

本节所示电路文件含有的内容包括：模数转换、数模转换及模-数的来回转换。您可以更改采 

样文件 AnalogToDigitalConverter.ms11、DigitalToAnalogConverter.ms11 及 ADC-DAC.ms11，使其更 

适合您具体的课程要求。DigitalToAnalogConverter.ms11 利用 Multisim 的“总线”功能在电路

构 建完成之前自动完成部分线路连接。本节针对每个文件提供了一份实验指导。 

目标 

 在 Multisim 环境中提供数字与模拟组合电路的实例。 

 介绍七段 BCD 显示器及 LED 指示灯。 

前提 

您需要用到以下电路文件： 
 AnalogToDigitalConverter.ms11 

 DigitalToAnalogConverter.ms11 

 ADC-DAC.ms11。 

 

学员须： 

 对模数及数模转换器的运行有一个初步的认识 

 熟悉 Multisim 的环境，包括各种模拟及数字测试设备的使用方法。 

相关实验指导 

 “实验指导 9-1：模数转换（ADC）” 

 “实验指导 9-2：数模转换（DAC）”。 
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将模拟输入转换为数字输入及反向转换 

应用 

这类似于磁带录音、CD 及视频的数字录制及回放用电路，但要比后几个简单。 

前提 

您需要用到文件 ADC-DAC.ms11。  

 

 

图 9-1：ADC-DAC.ms11 

运行 

 函数发生器驱动 SOC（转换的开始）及输入模拟信号的采样率。 

 数字值以十六进制的方式显示在两个七段数码管显示器上，并被传送给数模转换器进行数

字到模拟的反向转换。 



9-4  Multisim 之实用教学理念 

 

 

 

 

流程 

1. 打开文件 ADC-DAC.ms11。 

2. 让输入电位器处于 50%，计算模拟输入电压峰峰值。（展示计算结果。） 

V(in) = ________ v(p-p) 

3. 将采样率（函数发生器）设置为 1 kHz。 

4. 针对 100 Hz 的输入频率，计算出将要从每个输入循环中提取的采样数量。 

采样数量 = _________ 

5. 根据时间及幅值量程粗略地绘制出预期的输出波形。 

6. 将采样率及输入频率设置为上方所用的值，然后求解电路。 

7. 绘制输出波形。 

8. 评述预测输出值与实测输出值之间的关系。 
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9. 通过改变采样率的方式试验该 A-D 及 D-A 过程。（使输入频率和幅值保持在当前状 

态。）评述采样率与输出波形“失真”之间的关系。 

NI ELVIS 练习 

开始 

 
 

 

创建 ADC-DAC.ms11 所示电路。有许多电线连接至 ADC 芯片，所以，将任何东西连接至该芯

片 时须谨慎操作，尤其要注意位的顺序，以及您要连接的七段显示器驱动芯片是哪些。 

练习 

该电路有一路输入和一路输出。被您用作输入的电压应位于输出线上，因为您是要将该输入

转换为数字值，然后再将该数字值转换回模拟值。  

 

您将在输出中注意到的一个现象是“阶梯状波型”，这是因为您的数字信号有一个设定的分

辨率。阶梯的幅度将有多大？您怎样才能减小阶梯的幅度（提高分辨率）？ 
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实验指导 9-1： 

模数转换（ADC） 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 AnalogToDigitalConverter.ms11。 
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注 

 模拟输入由一个电位器来提供。该电位器代表了任何电阻性传感器，它可以感应的项目包

括：压力、温度、液面或控制系统中的任何其他参数。 

 Vin = (十进制数字输出)*Vref/256。 

 输出由 LED 指示灯以二进制方式显示，并由七段显示器以十六进制方式显示。 

 按下 A 键可增加输入，按下 SHIFT-A 键可减小输入。您也可以将指针移动到电位器上方并

拖 动出现的滑块。 

 将 SOC 端口短暂地短接至地线（方法：按下空格键两次）可初始化 SOC（转换的开

始）。 每次改变了输入的情况后都需要这样做。 

练习 

1. 这是一个 8 位 A/D 转换器。在参考电压为 5 V 的情况下，数字输出中的每个位代表了怎样 

的电压？展示计算结果。 

2. 如果数字输出为 6F（十六进制），模拟输入值是多少？展示计算结果。 
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3. 计算该 A/D 转换器可能会出现的预期误差。 

4. 确保 SOC 终端已连接至 Vcc（+5V）。求解电路。 

5. 十六进制的数字输出值是多少？ 

a) 计算模拟输入电压。展示计算结果。  

Vin = __________ V 

 

b) 输入电位器的设置为_________%。根据电位器设置来计算模拟输入电压。 

Vin = __________ V 

 

c) 对比两个读数。它们是否在上方计算出的预期误差范围以内？ 
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d) 输入电压表的读数是多少？ 

6. 上方计算出的读数与电压表的读数相比有何不同？请给予评述。 

7. 给电路输入几次 1.0 V 或以下的电压以及 4.0 V 或 以上的电压。记录所有读数（包括电压

表读数）， 并计算输入电压。对比模拟电压表来评述 A/D 转换器的准确性。 
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实验指导 9-2： 

数模转换（DAC） 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 DigitalToAnalogConverter.ms11。 

 

 

注 
 Vin 由开关 A 至 H 设置，并以十六进制和二进制两种方式显示 

 转换参考值为 10 V。 
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在开始这部分实验室工作之前，您必须在工作区内放好一个总线，并完成合理的连接。要连

接总线，请选择主菜单中的 Place»Bus。左键点击 VADC IC 正上方的工作区。横向拖动总

线， 直至它刚好与 VADC 平行，然后双击。左键点击 VADC，使其高亮显示。选择

Place»Bus Vector Connect 进行连接。此时将弹出 Bus Vector Connect 对话框。高亮显示 D0，然

后按下 SHIFT-D7，以此高亮显示 D0-D7。点击左下行箭头，将所有选定的插脚放在 Bus Vector 

Connect 对话框的左下栏中。选择 Bus1，然后点击 Auto-assign（自动分配）。点击 OK（确

认）关闭对 话框；总线连接将自动完成。点击每根线并根据说明框所给列表更改颜色。  

 

点击每根经过彩色编码的线，根据下方列表将它们与总线正确连接起来：D0 连接至深绿色； 

D1 连接至浅蓝色；D2 连接至棕色；D3 连接至粉红色；D4 连接至浅绿色；D5 连接至蓝色； 

D6 连接至黄色；D7 连接至红色。 

 

点击开关或选择主菜单中的 Simulate»Run 执行仿真程序。 

练习 

1. 这是一个 8 位 D/A 转换器。在参考电压为 10 V 的情况下，就模拟输出而言，每个位代表

了 怎样的电压？展示计算结果。 

2. 如果输出为 3.62 V，数字输入值是多少？展示计算结果。 

3. 计算该 D/A 转换器可能会出现的预期转换误差。 

4. 评述参考电压和转换准确度之间的关系。 
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流程 

1. 打开文件 DigitalToAnalogConverter.ms11。 

 

 

2. 将数字输入设置为 38（十六进制）。求解电路。模拟输出为__________ V。 

a) 针对所用的数字输入，计算可能的模拟输出，计算时请考虑到上方计算出的转换准确

度（最多可能会有三个）。展示计算结果。 

 

Vout = __________ V 

或者 
 

Vout = __________ V 

或者 
 

Vout = __________ V 

b) 输出读数是否在上方计算出的预期误差范围以内？ 

3. 再多读几次 0F（十六进制）或以下的以及 C0（十六进制）以上的输入。记录所有读数。 

4. 评述 D/A 转换器的准确性。 

5. 将参考电压改为 5 V，取若干次读数（如第 2 步），然后评述参考电压对转换准确度的影 

响。 





 

 

第 10 节：射频通信 

章节内容 

本节含有以下内容： 

 “介绍射频”（第 10-2 页） 

 “带热噪声源的射频放大器”（第 10-4 页）。 

本节实验指导 

本节所含实验指导始于实验指导 10-1 的第 1 页： 

 

 “实验指导 10-1：频谱分析简介” 

 “实验指导 10-2：调幅简介” 

 “实验指导 10-3：带安捷伦函数发生器的包络检波器” 

 “实验指导 10-4：调频简介”。 

本节电路 

下面列出了本节所用电路的名称，以及每个电路的简要描述。 

 
文件（.ms11）  描述 
AMIntroduction 一个含有 Circuit A（电路 A）和 Circuit B（电路 B）两个电

路的文件。Circuit A（电路 A）演示了调幅的基本概念。

Circuit B（电路 B）演示了 Multisim 的调幅器。 
EnvDetectorWithAgilentFG 一个含有包络检波器的文件，该包络检波器由安捷伦函数发

生器的调幅功能提供驱动。 
FMIntroduction 一个演示了 Multisim 调频器的电路。 
RFAmpWithThermalNoiseSource 一个让学员认识射频放大及噪音生成的文件。 
SpectrumAnalyzerIntro 一个让学员认识 Multisim 频谱分析仪的文件。 

 



10-2  Multisim 之实用教学理念 

 

 

介绍射频 

Multisim 拥有大量特别适用于射频电子学的功能， 

 

比如：高频分量、传输线、波导管，以及包括频谱分析仪和 Network Analyzer（网络分析仪）

在内的各种仪器。Multisim 向用户提供了一个调幅模块和一个调频模块，两者在本节中都有

用到。 

 

频谱分析仪、调幅传输及调频传输将在本节里进行介绍。课程将要求学员在示波器和频谱分

析仪上观察调幅及调频波形。  

 

电路文件 SpectrumAnalyzerIntro.ms11、AMIntroduction.ms11、EnvDetectorWithAgilentFG.ms11 及

FMIntroduction.ms11 将在本节里打开。文件 SpectrumAnalyzerIntro.ms11 在其说明框中介绍了频

谱分析仪的使用方法。 

目标 

介绍 Multisim 的调幅器、调频器及频谱分析仪，让学员熟悉这些仪器的使用方法。 

前提 

学员须： 

 熟悉 Multisim 环境，包括示波器 

 对调幅、调频及频谱分析已经有所认识。 

相关实验指导 

 “实验指导 10-1：频谱分析简介” 

 “实验指导 10-2：调幅简介” 

 “实验指导 10-3：带安捷伦函数发生器的包络检波器” 

 “实验指导 10-4：调频简介”。 
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图 10-1：频谱分析仪窗口 
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带热噪声源的射频放大器 

目标  

让学员熟悉射频电路分析并认识噪音生成的概念。 

注释 

热噪声源可见于主数据库的“信号电压源”类别中。 

流程 

1. 打开 RFAmpWithThermalNoiseSource.ms11。 

2. 打开说明框。 

3. 点击开关或选择 Simulate»Run 执行仿真程序。 
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实验指导 10-1： 

频谱分析简介 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 
打开文件 SpectrumAnalyzerIntro.ms11。 

 

 
 

 

注 
 本文件中介绍了频谱分析仪上频率控制的设置方法。 

 课程将要求学员更改这些设置，以查看方波的谐波。 
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练习 

1. 双击示波器窗口查看其屏幕显示。 

 

2. 点击开关或选择菜单中的 Simulate»Run 执行仿真程序，然后观察并测量正弦波的频率。 

 

 

 

 

 

3. 双击频谱分析仪以查看其屏显。  
 

 

 

 

 

4. 测量频谱分析仪上的频率，方法：拖拽红色 Marker（标记器）并观察频谱显示器底部右侧

的频率。将您得出的结果与第 2 步的结果进行对比。 

 

 

 

 

 

5. 双击函数发生器以查看其选择窗口。 

 

6. 选择矩形波，然后再次执行仿真程序。 

注意 3fo 和 5fo 是否存在。我们希望观察 7fo 和 9fo。要观察，您必须调节频谱分析仪，使 

其显示此类频率。用“中心”及“跨度”设置来进行此项操作。我们希望让 10 kHz 的频 

谱线出现在窗口左侧，让 9 x 10 kHz 的频谱线出现在窗口的极右侧，所以，将频率跨度 

（频率从窗口左侧到右侧的跨度）设置成 100 kHz 的做法是合情合理的。如果我们将“中 

心”频率设置成 50 kHz，5fo 将出现在窗口中心。 

 

7. 按上方建议进行更改，按“回车”键，然后按“开始”键。 

 

fo =    3fo =    5fo = 

 

7fo =    9fo = 
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实验指导 10-2： 

调幅简介 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 AMIntroduction.ms11。 
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注 

 该文件含有两个电路。Circuit A（电路 A）含有一个函数发生器（提供载波频率）和一个 

电位器（调节它可以相应地改变调制频率）。 

 电位器调节方法：按下 A 可以增加值，按下 SHIFT-A 可以减少值。您也可以将指针移动到

电 位器上方并拖动出现的滑块。 

练习 

Circuit A（电路 A） 

该电路演示了调幅的基本概念。来自函数发生器的 200 kHz信号代表着载波频率。  

 

1. 双击打开示波器窗口。 

2. 执行仿真程序，方法：按下开关或选择菜单中的 Simulate»Run。 

3. 点击图解窗口激活它，快速地按几次 SHIFT-A 键并观察效果。然后，快速地按几次 A 键并

观 察效果。您也可以将指针移动到电位器上方并拖动出现的滑块。  

4. 描述您所看到的情况。  

 

 

 

 

 

Circuit B（电路 B） 

1. 双击打开示波器窗口。 

2. 执行仿真程序。 

3. 用观察到的包络计算调制百分比。 

 

 

 

 

 

4. 双击频谱分析仪。请耐心等待。频谱显示器可能要几秒钟后才会出现。将红色 Marker（标 

记器）拖至各峰值，测量载波频率及上、下边带。 
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5. 观察在频谱显示器底部右侧看到的频率。 
 

fc =    fupper =    flower = 
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实验指导 10-3： 

带安捷伦函数发生器的包络检波器 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 
打开文件 EnvDetectorWithAgilentFG.ms11。 

 

 
 

注 

 安捷伦函数发生器的更多实例见第 4-2 节。 

 该文件利用 Multisim 的安捷伦函数发生器创建调幅波。 

 需要的所有公式都含于“电路描述文件”中。 
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练习 

该文件所含电路是一个包络检波器。使用包络检波器是解调调幅信号最简单的途径。设计包

络检波器是为了缩短充电时间并减缓放电时间。R2 控制着放电时间常数。   

 

 

 

 

1. 您将利用安捷伦函数发生器的调幅功能来生成调幅信号。双击打开安捷伦函数发生器窗 

口。点击 Shift，然后 选择 AM 。再点击 Freq 键，将载波频率设置为 100 kHz。按下 Ampl 

键，将载波信号的幅值设置为 10 V。按下 Shift 键，然后 Freq 键，将调制信号的频率设置 

为 500 Hz。按下 Shift Ampl 键，将值调节为 0.9，以此选择 90%的调制百分比。绘制出波 

形，标记好每个关键点，以此记录您得出的结果。 

 

2. 重新设计 R1 和 C1 的值，以满足“RC = 1/m2fm”的要求。双击分量以更换分量值。   

 

3. 执行仿真程序并检查您的结果。 
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实验指导 10-4： 

调频简介 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 
打开文件 FMIntroduction.ms11。 

 

 

注 

 载波频率、调制频率及调制指数可通过双击调频源的方式来更改。 

 实验指导也显示在文件的说明框中。 

 频谱分析仪使用方法概述见“频谱分析简介”。 
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练习 

1. 双击示波器以查看其屏幕显示。 

2. 按下开关或选择菜单中的 Simulate»Run 执行仿真程序。 

3. 观察输出，描述您观察到的结果。 

 

 

 

 

4. 双击频谱分析仪以查看其屏幕显示。请耐心等待。目标频谱线可能要几秒钟后才能看到。

找到 2 kHz 的载波频率，方法：拖拽红色 Marker（标记器）并观察频谱图右下方的频率。 

5. 用红色 Marker（标记器）找到下方列出的边带频率，并将它们的值记录下来。  

 

fc - 3 fm =    fc - 2fm =    fc - fm = 

 

fc + fm =    fc + 2fm =    fc + 3fm = 

 

6. 停止模拟。双击调频源，将调制指数改为 1.5。 

7. 执行仿真程序，并评述您观察到的结果。 

 

 



 

 

第 11 节：波导管及 Network Analyzer（网络分析

仪） 

章节内容 

本节含有以下内容： 

 “介绍波导管及 Network Analyzer（网络分析仪）”（第 11-2 页）。 

本节实验指导 

本节所含实验指导始于实验指导 11-1 的第 1 页： 

 

 “实验指导 11-1：波导管” 

 “实验指导 11-2：阻抗匹配”。 

本节电路 

下面列出了本节所用电路的名称，以及每个电路的简要描述。 

 
文件（.ms11） 描述 
ImpedanceMatching  该文件利用说明框演示了 Multisim Network Analyzer（网络分析仪） 

的阻抗匹配性能。 
Waveguide  一个含有波导管的文件，该波导管利用 Multisim 的 Network 

Analyzer（网络分析仪）进行研究。 
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介绍波导管及 Network Analyzer（网络分析仪） 

本节使用了波导管电路 Waveguide.ms11。更改波导管模块参数须双击模型，然后更改

“ SPICE”参数。学员可通过本节的两个文件认识 Network Analyzer（网络分析仪）。 

 

射频工程师利用 Multisim 设计射频放大器时需要使用 Network Analyzer（网络分析仪）。它

可用于测量电路的散射参数，此类参数体现了以高频率工作之电路的特性、振荡器的稳定

圆，以及单向增益圆。Network Analyzer（网络分析仪）将计算 H、Y 及 Z 的参数，并提供阻

抗匹配性能。阻抗匹配功能用于匹配无条件稳定电路的稳定部分。电路文件

ImpedanceMatching.ms11 利用 Network Analyzer（网络分析仪）来发挥其阻抗匹配特性。 

 

两个文件都有提供实验指导。 

目标 

让学员认识波导管、阻抗匹配及 Network Analyzer（网络分析仪）。 

前提 

我们假定，学员在尝试学习本节内容之前已经初步学习了波导管、史密斯圆图及阻抗匹配概

念。 

观察 

 波导管的“SPICE”参数可通过双击波导管并选择 Edit Model（编辑模型）的方式来读 

取。 

 文件 Waveguide.ms11 含有一个 L 波段的波导管。 

 我们建议更改 Network Analyzer（网络分析仪）的设置，以便观察其诸多功能。 
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图 11-1： Network Analyzer（网络分析仪）窗口 

相关实验指导 

 “实验指导 11-1：波导管” 

 “实验指导 11-2：阻抗匹配”。 
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实验指导 11-1： 

波导管 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 Waveguide.ms11。 
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注 

我们建议更改 Network Analyzer（网络分析仪）的设置，以便观察其展现出的诸多功能。 

 

练习 

1. 双击 Network Analyzer（网络分析仪）以查看其屏显。 

2. 执行仿真程序。注意，z 参数位于表示“R = 0”的单位圆旁。 

3. 记录 Z11 和 Z22 的值。 

 

Z11 = 

 

 

Z22 = 
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实验指导 11-2： 

阻抗匹配 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 ImpedanceMatching.ms11。 
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练习 

1. 双击 Network Analyzer（网络分析仪）以查看其屏显。 

2. 启动仿真程序。 

3. 从参数下拉列表中选择 Stability factor（稳定系数）。用滚动条将频率更改至 5.2481 GHz. 

 

4. 记录处于此频率的 delta 值和 K 值。 

 

Delta = 

 

 

K = 

 

 

5. 检查放大器在此频率上是否“无条件稳定”。 

6. 从 Mode 区域的下拉列表中选择 Match Net Designer（匹配网络设计程序）。将频率改为 

5.2482 GHz，作为理想的工作点。此时会弹出 Match Net Designer 对话框。 

7. 选择 Impedance Matching（阻抗匹配）标签并启用 Auto Match（自动匹配）功能。此时会显 

示设计元件及其值。将结构绘制出来。 

 

 

 



 

 

第 12 节：学员测评及实验室预习 

章节内容 

本节含有以下内容： 

 “改善测评技巧”（第 12-3 页） 

 “实验室模拟试验”（第 12-4 页） 

 “实验室预习任务”（第 12-5 页）。 

本节的试题及实验指导 

本节的试题及实验指导始于“试题 1”的第 1 页： 

 “试题 1” 

 “试题 2” 

 “试题 3” 

 “试题 4” 

 “实验指导 12-1：实验室预习任务 1” 

 “实验指导 12-2：实验室预习任务 2” 

 “实验指导 12-3：实验室预习任务 3” 

 “实验指导 12-4：实验室预习任务 4” 

 “实验指导 12-5：实验室预习任务 5”。  
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本节电路 

下面列出了本节所用电路的名称，以及每个电路的简要描述。 
 
文件（.ms11）  描述 
Board  模型板的仿真过程，目的是让学员熟悉此类模型板的内部连接。 
Test13  一个故障削波器。 
Test1 and Test2  有关运算放大器的抽样测试和小测验。 
Test11 and Test12  
 

故障场效应晶体管电路 

Test14  故障钳位器电路。 
Test15 and Test16  两个故障齐纳二极管电路。 
Test17 and Test20  利用频谱分析仪进行故障测试。 
Test18 and Test19  故障桥式整流器。 
Test22  一个故障带通滤波器。 
Test3 and Test21  设计的两项试验，需要学员对频谱分析仪进行设置，以查看指定的

频谱成分。 
Test4  一个故障串联电路。 
Test5 – Test7  故障共集电极电路。 
Test8 – Test10  故障共射极电路。 
Pre-Lab1-Pre-Lab5 进入实验室之前需要完成的预习工作。 
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改善测评技巧 

Multisim 向作为标准并被沿用多年的评测限制提出了挑战。通过它，学员可以进行出色的总

结性评估，并将评估结果成功地利用起来。 

 

在总结性评估流程中采用 Multisim 的优势（在本节中探讨）： 

 节省打分时间  

 突出强调学生出现的数值误差与概念误差之间的区别 

 各学员可轻松快速地实现自定义设置，防止被拷贝抄袭 

 可以打印后分发，也可复制到磁盘后上交 

 以小组方式学习的学员以及独立完成大多数学习的学员可以因其成绩而得到表扬。 

 

有了 Multisim，您也可以分发可供学员使用的打印版资料，或是分发您想在 Multisim 格式下

呈现的任何原理图。您可以请学员回答有关分发材料的选择题。此外，您也可以让学员绘制

出具体电路的预期输出。您也可以请他们完成一项难度较大的任务：绘制出某个黑匣子中的

内容。 

 

一种很好的评测方式是，使用任何特定电路所含的说明框。学员可以回答说明框中的问题，

并将结果拷贝到磁盘后提交。 
 

要使用说明框 

1. 请打开电路文件。选择 Tools»Description Box Editor。 

2. 开始键入您的试题或测验。您想输入多少字都可以。 

 

注： 说明框的内容可以打印出来供其他评测手段使用。电路和说明框可以打印出来用于测 

验。要打印原理图，请选择 File»Print。要独立打印一个或多个仪器，请选择 File»Print 

Options»Print Instruments。要打印出不显示结果的电路，请运行文件，然后迅速停止运 

行。所有值都将被设置成零。您也可以使用 Simulate»Clear Instrument Data 命令来清除

所 有仪器及记录器上的数据。  
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实验室模拟试验 

目标 

创造一个对学员很有意义的试验情境，既要求学员做理论计算，也要求他们展示出用合理的

测试设备求解电路的能力。 

Test1 评述 

试题 1 中含有一个需要学员在执行仿真程序之前求解的电路，就像在常规笔试中一样。仿真

完毕后，学员须测量先前在纸上求解过的参数。  

 

学员提交了笔试部分之后才能开始执行仿真程序。 

Test2 评述 

试题 2 要求学员熟练掌握测试设备及测量技巧。值被隐藏起来时，学员须通过测量元件的方

式来判断电路性能。 

Test3 评述 

在评测中使用了 Multisim 的情况下，多项试题及测验都可以轻松设置并打分。使用 Multisim 

可以让多项试题的执行过程变得非常简单。电路文件（如：Test3.ms11）可以更改试题后快速

复制和打印，方法很简单：双击元件值并改动它们。然后，这些文件就可以以打印版或电子

版的形式供学员来评测。 

 

试题 3 列举了不使用解集的情况下给试题打分的方法。可以给电路文件中放置指示符，以便

就所有试题给您提供快速的求解方案。只需创建一个求解方案文件。对于涉及不同元件值的

多项测验，求解文件的元件值可以用即时结果轻松更改。 

 

在试题中犯了简单错误的学员（如：使用了另一个错误的元件值）所丢的分数往往过多，这

种评测结果是没有必要且有失公平的。利用 Multisim，此类问题便迎刃而解，您只需要将值

改成学员所用的值，然后检查他们的模拟结果。 

 

 

相关试题 

 “试题 1” 

 “试题 2” 

 “试题 3” 
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 “试题 4”。 

实验室预习任务 

目标 

 加强在您的学校里使用有限的实践型实验室的能力 

 降低备用零部件/测试设备的成本。 

前提 

您需要用到电路文件 Board.ms11、Pre-Lab.ms11、Clipper.ms11、Clamper.ms11、Transistor.ms11 

以及 Template.ms11。 

注释 

用 Multisim 环境代替学员最初的实验室体验的做法可大幅降低仪器及元件的更换成本。不 

过，模拟环境并不能取代传统实验室。学员不但要会用模拟和真实的元件，也要会用工业仪

器。 

 

在接触物理设备之前，学员就已经可以熟练使用仪器和元件了。更多高效率的实验室工作会

让学员出成绩。更低的损毁率，让更多的预算回到课堂当中来，这种做法也会让学员出成 

绩。 
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推荐的流程 

第一部分：仿真电路行为 
学员可能需要在给出的实验指导上绘制预期的示波器描迹。如果该实验指导被正确完成，讲

师将在上面签名，然后，学员才能执行仿真程序并继续学习该实验室预习任务的第二部分。

您可以为不同的实验室组创建一系列唯一的文件。 
 

第二部分：仿真试验电路板的构建 
在该实验室预习任务的第二部分中，您可以让学员在虚拟的试验电路板上构建并模拟电路。

此练习能够尽可能逼真地模拟出他们今后会在实践型实验室中遇到的情景。  

概念扩展 

熟练使用 Multisim 软件本身就可以被当作是一项实验室预习任务。另外，Multisim 的面包板 

试验功能可以并入本练习册中的任意一个实验室中。学员须能够演示测试设备的正确使用方

法，然后才能接触和使用真实的仪器。他们可以首先仿真自己计划要构建的电路。只要可行

时，就采用该策略。 

相关实验指导 

 “实验指导 12-1：实验室预习任务 1” 

 “实验指导 12-2：实验室预习任务 2” 

 “实验指导 12-3：实验室预习任务 3” 

 “实验指导 12-4：实验室预习任务 4” 

 “实验指导 12-5：实验室预习任务 5” 
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试题 1 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开电路文件 Test1.ms11。 

 

 

练习 
1. 利用基本的运算放大器理论计算所示电路的电压增益、-3dB 上频率和下频率，以及可 

能的最高无畸变输出电压。（您可以从运算放大器模型库中了解运算放大器的特 

性。） 

2. 记录所有答案并展示计算过程。 

3. 模拟文件 Test1.ms11 并测量电路性能（如练习 2 中的计算方法）。要测量 -3dB 频

率，请使用信号发生器、示波器（或万用表）及波特图绘制器。 

4. 您在 Multisim 中的求解方案必须以文件方式提交。请将所有使用过的仪器设置包含在 

内。 
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试题 2 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开文件 Test2.ms11。 

 

 

流程 

1. 求解电路并对测试设备进行任何必要的设置，以找出阈值电压的值。 

2. 请讲师查看屏幕检查您的求解方案。 

3. 将您的求解方案保存在磁盘上，包括所示求解方案所用到的测试设备，然后交给讲师。填

写下方问题 1、2 的答案。 

 

问题 
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1. 识别出电路类型。 

2. 找出阈值电压的值。  

V (阈值) = 
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试题 3 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开 Test3.ms11。 
 

 

流程 

1. 调节频谱分析仪，以显示输出。 

 

2. 给讲师展示您的结果。 
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试题 4 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开 Test4.ms11。 
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推荐的流程 

A 部分可能代表了提供给学员的测验。可以使用说明框来让学员找出 IB、VCA、VBD、VB 

和 VC。您只需双击元件并更改它们的值，多项测验即可生成。 

 

B 部分是与 A 部分相同的电路。利用基本的运算放大器理论计算所示电路的电压增益、-3dB 

上频率和下频率，以及可能的最高无畸变输出电压。您只需将元件值改为某学员的值并观察

结果，单个测验即可打分。 
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实验指导 12-1： 

实验室预习任务 1 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

观察下方图表。该图表可见于文件 Board.ms11 中。 

 

 
 

打开电路文件 Pre-Lab.ms11。 
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练习 

对部分学员而言，实验板使用起来可能会比较困惑。文件 Board.ms11 主窗口中的图是想向您

展示插脚在电路板内部的连接方式。用该实验板制作 Pre-Lab.ms11 中的试验电路。 

 

 
 

 

1. 选择 Tools»Show Breadboard。此时将显示仿真的试验电路板环境。点击箭头可显示存在于 

原理图中的各个元件。制作 Pre-Lab.ms11 中的试验电路，方法：将各元件拖至试验电路板 

上，然后创建连接。 

 

2. 保存您的电路，然后请讲师检查并签名。___________ 

 

3. 假定三角波输入为 1 kHz 和 6V，请绘制示波器（按其现在的连接方式）的预期结果。 
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实验指导 12-2： 

实验室预习任务 2 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

 

开始 

打开 Clipper.ms11。 

 

 

注 

对部分学员而言，实验板使用起来可能会比较困惑。文件 Board.ms11 主窗口中的图是想向您

展示插脚在电路板内部的连接方式。使用 Board.ms11 实验板来制作 Clipper.ms11 中的试验电

路。 
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1. 选择 Tools»Show Breadboard。此时将显示仿真的试验电路板环境。  

2. 点击箭头可显示存在于原理图中的各个元件。  

3. 制作 Clipper.ms11 中的试验电路，方法：将各元件拖至试验电路板上，然后创建连接。 

4. 保存您的电路，然后请讲师检查并签名。___________ 

5. 假定正弦波为 10 V 和 1 kHz，请绘制预期的输出。   
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实验指导 12-3： 

实验室预习任务 3 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开 Clamper.ms11。 
 

 

注 
 

对部分学员而言，实验板使用起来可能会比较困惑。文件 Board.ms11 主窗口中的图是想向您

展示插脚在电路板内部的连接方式。使用 Board.ms11 实验板来制作 Clamper.ms11 中的试验电

路。 
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1. 选择 Tools»Show Breadboard。此时将显示仿真的试验电路板环境。  

2. 点击箭头可显示存在于原理图中的各个元件。  

3. 制作 Clamper.ms11 中的试验电路，方法：将各元件拖至试验电路板上，然后创建连接。 

4. 保存您的电路，然后请讲师检查并签名。___________ 

5. 假定信号为 20 V 和 1 kHz，请绘制预期的波形。 
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实验指导 12-4： 

实验室预习任务 4 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开 Transistor.ms11。 

 

 

注 

对部分学员而言，实验板使用起来可能会比较困惑。文件 Board.ms11 主窗口中的图是想向您

展示插脚在电路板内部的连接方式。使用 Board.ms11 实验板来制作 Transistor.ms11 中的试验电 

路。 
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1. 选择 Tools»Show Breadboard。此时将显示仿真的试验电路板环境。   

2. 点击箭头可显示存在于原理图中的各个元件。  

3. 制作 Transistor.ms11 中的试验电路，方法：将各元件拖至试验电路板上，然后创建连接。  

4. 保存您的电路，然后请讲师检查并签名。___________ 

5. 计算 IB、IC 和 IE 

 

 

 

 

6. 计算 VCE 

 

 

 

 

7. 计算最高无削波输入电压。 
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实验指导 12-5： 

实验室预习任务 5 

姓名：__________________________ ID 号：___________________ 班级：_______________________ 

开始 

打开 Template.ms11。 

 

 

注 

对部分学员而言，实验板使用起来可能会比较困惑。文件 Board.ms11 主窗口中的图是想向您

展示插脚在电路板内部的连接方式。使用 Board.ms11 实验板来制作 Template.ms11 中的试验电

路。 
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1. 选择 Tools»Show Breadboard。此时将显示仿真的试验电路板环境。  

2. 点击箭头可显示存在于原理图中的各个元件。   

3. 制作 Template.ms11 中的试验电路，方法：将各元件拖至试验电路板上，然后创建连接。 

4. 保存您的电路，然后请讲师检查并签名。___________ 

5. 求解电路并对测试设备进行任何必要的设置，以找出阈值电压的值。 

6. 请讲师看屏幕检查您的求解方案。 

7. 将您的求解方案保存在磁盘上，包括所示求解方案所用到的测试设备，然后交给讲师。 

8. 请务必填写下方问题#1、#2 的答案。 

 

问题 

 

1.   识别出电路类型。  

 

 该电路是 _______________________________________。 

 

2.   阈值电压的值。 

 

 V (阈值) = ___________ 


